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Legal Information

The Schneider Electric brand and any registered trademarks of Schneider Electric
Industries SAS referred to in this guide are the sole property of Schneider Electric SA
and its subsidiaries. They may not be used for any purpose without the owner's
permission, given in writing. This guide and its content are protected, within the
meaning of the French intellectual property code (Code de la propriété intellectuelle
frangais, referred to hereafter as "the Code"), under the laws of copyright covering
texts, drawings and models, as well as by trademark law. You agree not to reproduce,
other than for your own personal, noncommercial use as defined in the Code, all or
part of this guide on any medium whatsoever without Schneider Electric's permission,
given in writing. You also agree not to establish any hypertext links to this guide or its
content. Schneider Electric does not grant any right or license for the personal and
noncommercial use of the guide or its content, except for a non-exclusive license to
consult it on an "as is" basis, at your own risk. All other rights are reserved.

Electrical equipment should be installed, operated, serviced, and maintained only by
qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

As standards, specifications, and designs change from time to time, please ask for
confirmation of the information given in this publication.
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Safety information

Important information

Please note

Read these instructions carefully and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this manual or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

The addition of either symbol to a “Danger” or “Warning” safety label indicates
that an electrical hazard exists which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal injury
hazards. Obey all safety messages that accompany this symbol to avoid possible
injury or death.

ADANGER

DANGER indicates a hazardous situation which, if not avoided, will result in
death or serious injury.

Failure to follow these instructions will result in death or serious injury.

AWARNING

WARNING indicates a hazardous situation which, if not avoided, could result
in death or serious injury.

A CAUTION

CAUTION indicates a hazardous situation which, if not avoided, could result in
minor or moderate injury.

NOTICE

NOTICE is used to address practices not related to physical injury.

Electrical equipment should be installed, operated, serviced and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material. A qualified person is one who
has skills and knowledge related to the construction, installation, and operation of
electrical equipment and has received safety training to recognize and avoid the
hazards involved.
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Notices

FCC

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that the interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

+ Connect the equipment to an outlet on a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced radio/TV technician for help.

The user is cautioned that any changes or modifications not expressly approved
by Schneider Electric could void the user’s authority to operate the equipment.

This digital apparatus complies with CAN ICES-3 (B) /NMB-3(B).

EAV15107-ENO5



PowerLogic™ PM5300 series

Table of Contents

Safety preCautions ..o 9
MELEr OVEIVIEW .......oiiiiiiiie e 10
Features and options ..........oooiiiiiii i 10
Data display and analysis t0O0IS ............ccieuiiiiiii e 12
Meter configuration............oooeuiiiiiiiii e 12
Hardware reference..............ccoovooiiiiiiiicieccc e, 14
Parts of the meter (rear VIEW)..........oouiiiiiiiiii e 14
LED indicators on the display......... .o 14
Panel-mount meter mounting and wiring recommendations ........................ 15
TErmMINAl COVEIS ...t e e e eenns 15
Meter wiring considerations ............oooeiiiiiiii e 16
Communications CONNECLIONS .........ccuuiiiiiiiiii e 18
DISPIAY ... 19
DiSPlay OVEIVIEW ...ttt 19
NOtIfiICatioN ICONS ... e 19
Meter display [angQuage ........c..eiiiiiii e 19
Meter screen Navigation ...........c.ooeiiiii i 20
Data display SCrEENS......... it 23
HMI SEIUD SCIEENS ...t 26
Settingup the display .........ocooiiiiii i 26

BaSIC SEIUD ..o 28
Configuring basic setup parameters using the display.............ccccccooieeins 28
Configuring advanced setup parameters using the display................cc........ 30
Setting up regional Settings ............iiiiiiiii 30
Setting up the screen PassSWOrds .........c.uuiiiiiiiiiie e 31
LOSt USEI @CCESS ..t eeeiieeeet et 32

Setting the ClocK ... 32
CommMUNICAtIONS ... 34
Serial commUNICAtIONS .......oioui i e 34
Ethernet communications ... 35
BACNEUYIP ... 37
Supported BACNEt features .........cccuuiviiiiiiiiieiiiie e 37
BACnet/IP communications implementation...............c...ccoooii. 39
BACNEt ODJECES ... e 40
LOGGING et 50
= = 1 [ Yo [P TUPPRR 50

Y = 5 2 1 o T R 51
Memory allocation for 10g fileS...........uiiiiiiiiiii e 51
MaiNtENANCE 10G ... 51
INPULS / OULPULS ... 52
Available [/O POIS .....ceie s 52
Status input @appliCations ..........cooouiiiii 52
Digital output applications............cccouiiiiiii e 54
Relay output appliCations ..........coouiiiiiii e 57
ENergy PUISING ......eu e 59
ALBIMNIS .. 62
EAV15107-ENO5 5



PowerLogic™ PM5300 series

AlBIMS OVEIVIEW ... e 62
AVailable alarmsS .. ... 62
UNAIY @larms......cooueiieei e 62
Available unary alarms ..o 62

Digital @larmS .. .ee i 62
Standard alarms ... ... e 63
Alarm Priofties ... 67
Alarm SELUP OVEIVIEW ... 68
LED alarm indiCator ........co.uuiiiiii e 71
Alarm display and notification ... 71
Active alarms list and alarm history 109 ...........coooeiiiiiiiii 72
Viewing active alarm details using the display .............cccocceiiiiiin. 72
Viewing alarm history details using the display .............cccccoeeeiiiiin. 73
Viewing alarms counters using the display ............ccccoocoiiiiiii. 73
Acknowledging high-priority alarms using the display..............cc............ 73
Resetting alarms using ION Setup..........cociiiiiiiiiiic e, 73
MEASUIEMENTS ......oeeieiieeee e 75
Real-time readings .........oviiii i 75

] 1= ) PSP 75
MiIN/MAX VAIUES ... e 75
19723 0 =1 g T 75
oA =T i = Tox (o) ol (o o TP 79
01T TR 83
RESEES. ... 84
MUI-EANITTS ... 86
Y LU LT = 1 U 86
Command MOAE OVEIVIEW .........ccveeiiieeeiiiiiie et e e e e et e e e e e e e eaeanas 87
Time of day MOAE OVEIVIEW .......couuuiiiiiiiiii e 87
INPUL MOAE OVEIVIEW ... 90
POWeEr QUAIILY ..., 92
Power quality measurements...........oi i 92
HarMONICS OVEIVIEW ...t e 92
Total harmonic distortion ... 92
Total demand distortion ... ... 92
Harmonic content calculations .............oooiiiiiii i 93
THD% CalCUlatioNS ........oiiiiiiiie e 93
thd calCulations .........oooi e 93
BB B 7= (o0 =1 o] o - R 93
Viewing harmonics using the display .............ociiiiiiii 93
Viewing TDD using the display...........coouiiiiiiii e 94
Viewing THD/thd using the display ...........coi o 94
MaINtENANCE ... 96
MaintENANCE OVEIVIEW ........iiii e 96
0TS AT LT = Totod =TT 96
POWer Meter MEeMOIY ......co.uuiiiie e 96
Firmware version, model and serial number...............cc.cooiiii . 96
Diagnostics information ..............coooiiiii i 98
TroubleShOOING. .. .cieiie e 98
Technical @sSiStanCe..........couu i 100

6 EAV15107-ENO5



PowerLogic™ PM5300 series

VErifyiNng @CCUIACY .........cocoviiuiiiiiiee et 101
Overview of MEter aCCUracCy ...........couuviiiiiiiiiieeiie e, 101
Accuracy test requIremMents ..o 101

ENergy PuUISING......c.u i 102
Meter settings for accuracy testing..........coooeviiiiiiiiicie e, 102
Verifying accuracy teSt ... ..o 102
Accuracy verification test pointS..........cooooiiiii i 105
Energy pulsing considerations ............cooouuiiiiiiiiiiee e 105
VTand CT conSiderations...........oeuuiuiiiiiiiie e 105
Total power lIMitS........oii e 106
Typical sources of teSt errors ........cocuviiiiiiei e 106

MID complianCe .........ccooiiiiiiii e 107
MID-compliant MOdElS .........coouuiiiiiiiii e 107
Protected setup parameters and functions..............cccoeeviiiiiiiii e, 107
Locking or unlockingthe meter ..o, 107
Setting up the loCK PasSWOrd ...........c.u i, 108

Device specifications...............coooooiiiiiii e 109

EAV15107-ENO5 7






Safety precautions PowerLogic™ PM5300 series

Safety precautions

Installation, wiring, testing and service must be performed in accordance with all
local and national electrical codes.

ADANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

* Apply appropriate personal protective equipment (PPE) and follow safe
electrical work practices. See NFPA 70E in the USA, CSA Z462 or
applicable local standards.

» Turn off all power supplying this device and the equipment in which it is
installed before working on the device or equipment.

» Always use a properly rated voltage sensing device to confirm that all power
is off.

» Treat communications and I/O wiring connected to multiple devices as
hazardous live until determined otherwise.

» Do not exceed the device’s ratings for maximum limits.

* Never short the secondary of a potential/voltage transformer (PT/VT).
» Never open circuit a current transformer (CT).

* Always use grounded external CTs for current inputs.

* Do not use the data from the meter to confirm power is off.

* Replace all devices, doors and covers before turning on power to this
equipment.

Failure to follow these instructions will result in death or serious injury.

NOTE: See IEC 60950-1:2005, Annex W for more information on
communications and I/O wiring connected to multiple devices.

AWARNING

UNINTENDED OPERATION

Do not use this device for critical control or protection applications where human
or equipment safety relies on the operation of the control circuit.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

AWARNING

POTENTIAL COMPROMISE OF SYSTEM AVAILABILITY, INTEGRITY, AND
CONFIDENTIALITY

» Change default passwords to help prevent unauthorized access to device
settings and information.

» Disable unused ports/services and default accounts, where possible, to
minimize pathways for malicious attacks.

» Place networked devices behind multiple layers of cyber defenses (such as
firewalls, network segmentation, and network intrusion detection and
protection).

» Use cybersecurity best practices (for example: least privilege, separation of
duties) to help prevent unauthorized exposure, loss, modification of data and
logs, interruption of services, or unintended operation.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

EAV15107-ENO5 9
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Meter overview

Meter overview

Features and options

The PowerLogic™ PM5300 power and energy meters offer value for the
demanding needs of your energy monitoring and cost management applications.

PM5310 PM5320 PM5330 PM5340
PM5331 PM5341

Fast installation, panel mount with integrated display | v/ v v v
Accuracy Cl0.58 Cl0.58 Cl0.58 Cl0.58
Display v v v v
Backlit LCD, multilingual, bar graphs, 6 lines, 4
concurrent values
Power and energy metering: 3-phase voltage, v v v v
current, power, demand, energy, frequency, power
factor
Multi-tariff 4 4 4 4
Power quality analysis: THD, thd, TDD v v v v
Power quality analysis: Harmonics, individual (odd) 31st 31st 31st 31st
up to
I/0 281/2DO 2S1/2DO 281/2DO 281/2DO
Relays — — 2 2
Alarms 35 35 35 35
Setpoint response time, seconds 1 1 1 1
Single and multi-condition alarms v v v v
Communications: Serial ports with Modbus protocol 1 — 1 —
Communications: Ethernet port with Modbus TCP — 1 — 1
and BACnet/IP
MID-ready compliance — — PM5331 PM5341

Functions and characteristics

General
Use on LV and MV systems v
Basic metering with THD and min/max readings | v’
Instantaneous rms values
Current (per phase and neutral) v
Voltage (total, per phase L-L and L-N) v
Frequency v

Real, reactive, and apparent power (Total and
per phase)

Signed, Four Quadrant

True Power Factor (Total and per phase)

Signed, Four Quadrant

Displacement PF (Total and per phase)

Signed, Four Quadrant

% Unbalanced I, V L-N, V L-L

v

10
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Energy values

Accumulated Active, Reactive and Apparent
Energy?

Received/Delivered; Net and absolute

1Stored in non-volatile memory

Demand values

Current average'

Present, Last, Predicted, Peak, and Peak Date
Time

Active power?

Present, Last, Predicted, Peak, and Peak Date
Time

Reactive power?

Present, Last, Predicted, Peak, and Peak Date
Time

Apparent power?!

Present, Last, Predicted, Peak, and Peak Date
Time

Demand calculation (Sliding, fixed and rolling
block, thermal methods)

v

Synchronization of the measurement window to
input, communication command or internal clock

v

Configurable demand intervals

1Stored in non-volatile memory

Power quality measurements

THD, thd (Total Harmonic Distortion) I, V L-N, V
L-L per phase

I, VL-N, VL-L

TDD (Total Demand Distortion)

v

Individual harmonics (odds)

31st

Other measurements

1/0 timer?

Operating timer?

Load timer?

Alarm counters and alarm logs

SIS SIS

1Stored in non-volatile memory

Data recording

Min/max of instantaneous values, plus phase
identification?

v

Alarms with 1s timestamping’

Data logging Up to two fixed parameters (e.g.,
kWh and kVAh) with configurable interval and
duration (e.g., 2 parameters for 60 days at 15
minutes interval)

Memory capacity 256 kB
Min/max log v
Maintenance, alarm and event logs v
1Stored in non-volatile memory
Inputs/Outputs/Relays

Digital inputs 2
Digital outputs 2
Form A Relay outputs 2

EAV15107-EN0O5
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Timestamp resolution in seconds 1

Whetting voltage v

Data display and analysis tools

Power Monitoring Expert

EcoStruxure™ Power Monitoring Expert is a complete supervisory software
package for power management applications.

The software collects and organizes data gathered from your facility’s electrical
network and presents it as meaningful, actionable information via an intuitive web
interface.

Power Monitoring Expert communicates with devices on the network to provide:
+ Real-time monitoring through a multi-user web portal
» Trend graphing and aggregation
* Power quality analysis and compliance monitoring
» Preconfigured and custom reporting

See the EcoStruxure™ Power Monitoring Expert online help for instructions on
how to add your device into its system for data collection and analysis.

Power SCADA Operation

EcoStruxure™ Power SCADA Operation is a complete real-time monitoring and
control solution for large facility and critical infrastructure operations.

It communicates with your device for data acquisition and real-time control. You
can use Power SCADA Operation for:

» System supervision

* Real-time and historical trending, event logging

* Real-time and historical trending, event logging and waveform capture
+ PC-based custom alarms

See the EcoStruxure™ Power SCADA Operation online help for instructions on
how to add your device into its system for data collection and analysis.

Modbus command interface

Most of the meter’s real-time and logged data, as well as basic configuration and
setup of meter features, can be accessed and programmed using a Modbus
command interface and the meter’s Modbus register list.

This is an advanced procedure that should only be performed by users with
advanced knowledge of Modbus, their meter, and the power system being
monitored. For further information on the Modbus command interface, contact
Technical Support.

See your meter’s Modbus register list at www.schneider-electric.com for the
Modbus mapping information and basic instructions on command interface.

Meter configuration
Meter configuration can be performed through the display or PowerLogic™ ION
Setup.

ION Setup is a meter configuration tool that can be downloaded for free at
www.schneider-electric.com.

12 EAV15107-ENO5
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See the ION Setup online help or in the ION Setup device configuration guide. To
download a copy, go to www.schneider-electric.com and search for ION Setup
device configuration guide.

EAV15107-EN0O5 13
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Hardware reference

Hardware reference

Supplemental information

This document is intended to be used in conjunction with the installation sheet that
ships in the box with your device and accessories.

See your device’s installation sheet for information related to installation.

See your product’s catalog pages at www.schneider-electric.com for information
about your device, its options and accessories.

You can download updated documentation from www.schneider-electric.com or
contact your local Schneider Electric representative for the latest information
about your product.

Parts of the meter (rear view)

Most of the input, output and communication ports are located on the back of the
meter.

Relay outputs

Voltage inputs

Control power

Current inputs

m|oOo|O| ®m| >

Status inputs/Digital outputs

n

Communication port (Ethernet or RS-485)

G | Gasket

LED indicators on the display

The display has two LED indicators.

A | Alarm/ energy pulsing LED (orange)

A
B

Heartbeat / communications LED (green)

Alarm / energy pulsing LED

The alarm / energy pulsing LED can be configured for alarm notification or energy
pulsing.

When configured for alarm notification, this LED flashes when a high, medium or
low priority alarm is tripped. The LED provides a visual indication of an active
alarm condition or an inactive but unacknowledged high priority alarm.

14
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When configured for energy pulsing, this LED flashes at a rate proportional to the
amount of energy consumed. This is typically used to verify the power meter’s
accuracy.

NOTE: The alarm / energy pulsing LED on the MID model is permanently set
for energy pulsing and cannot be disabled or used for alarms.

Heartbeat / serial communications LED

The heartbeat / serial communications LED blinks to indicate the meter’s
operation and serial Modbus communications status.

The LED blinks at a slow, steady rate to indicate the meter is operational. The LED
flashes at a variable, faster rate when the meter is communicating over a Modbus
serial communications port.

You cannot configure this LED for other purposes.

NOTE: A heartbeat LED that remains lit and does not blink (or flash) can
indicate a hardware problem.

Ethernet communications LEDs

The meter has two LEDs for the Ethernet communications port.

The Link LED is on when there is a valid Ethernet connection. The Act (active)
LED flashes to indicate the meter is communicating through the Ethernet port.

You cannot configure these LEDs for other purposes.

Panel-mount meter mounting and wiring recommendations

Terminal covers

There are supplemental mounting and wiring recommendations that apply to
panel-mount meters.

* The meter is intended to be mounted inside a 74-DIN panel cutout.

* Inspect the gasket (installed around the perimeter of the display) and make
sure it is secured properly and not damaged.

+ The meter retainer clips, located on either side of the meter base and used to
secure the meter in the panel, do not usually require any tools to install.

The voltage and current terminal covers help prevent tampering with the meter’s
voltage and current measurement inputs.

The terminal covers enclose the terminals, the conductor fixing screws and a
length of the external conductors and their insulation. The terminal covers are
secured by tamper-resistant meter seals.

These covers are included for meter models where sealable voltage and current
covers are required to comply with revenue or regulatory standards.

The meter terminal covers must be installed by a qualified installer.

Refer to your meter's installation sheet or the instructions that came with your
terminal covers for instructions on installing the terminal covers.

EAV15107-EN0O5
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Hardware reference

Meter wiring considerations

Direct connect voltage limits

You can connect the meter’s voltage inputs directly to the phase voltage lines of
the power system if the power system’s line-to-line or line-to-neutral voltages do

not exceed the meter’s direct connect maximum voltage limits.

The meter's voltage measurement inputs are rated by the manufacturer for up to
400 V L-N /690 V L-L. However, the maximum voltage allowed for direct
connection may be lower, depending on the local electrical codes and regulations.
In US and Canada the maximum voltage on the meter voltage measurement

inputs may not exceed 347 V L-N /600 V L-L.

If your system voltage is greater than the specified direct connect maximum
voltage, you must use VTs (voltage transformers) to step down the voltages.

ungrounded

Power system Meter setting Symbol Direct connect Direct connect # of VTs (if
description maximum (UL) maximum (IEC) required)
Single-phase 2-wire | 1PH2W LN 347V L-N 400 VL-N 1VT
line-to-neutral

Single-phase 2-wire | 1PH2W LL 600 V L-L 600 V L-L 1VT
line-to-line

Single-phase 3-wire | 1PH3W LL with N 347 VL-N/600V 400V L-N/690V 2VT
line-to-line with L-L L-L

neutral

3-phase 3-wire 3PH3W DIt Ungnd 600 V L-L 600 V L-L 2VT
Delta ungrounded é

3-phase 3-wire 3PH3W DIt Crnr 600 V L-L 600V L-L 2VT
Delta corner Gnd

grounded

3-phase 3-wire Wye | 3PH3W Wye Ungnd 600 V L-L 600 V L-L 2VT

16
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Power system Meter setting Symbol Direct connect Direct connect # of VTs (if
description maximum (UL) maximum (IEC) required)
3-phase 3-wire Wye | 3PH3W Wye Gnd 600 V L-L 600 V L-L 2VT
- %
3-phase 3-wire Wye | 3PH3W Wye Res 600 V L-L 600 V L-L 2VT
resistance-grounded | Gnd %
3-phase 4-wire open | 3PH4W Opn DIt Ctr 240 VL-N/415V 240V L-N/415V 3VT
Delta center-tapped | Tp L-N/480V L-L L-N/480V L-L
3-phase 4-wire 3PH4W DIt Ctr Tp 240V L-N/415V 240 VL-N/415V 3VT
Delta center-tapped L-N/480V L-L L-N/480V L-L
é N
3-phase 4-wire 3PH4W Wye Ungnd 347 VL-N/600V 347 VL-N/600V 3VTor2VT
ungrounded Wye L-L L-L
N
3-phase 4-wire 3PH4W Wye Gnd 347 V L-N /600 V 400V L-N/690V 3VTor2VT
grounded Wye L-L L-L
N
3-phase 4-wire 3PH4W Wye Res 347V L-N /600 V 347V L-N/600V 3VTor2VT
resistance-grounded | Gnd L-L L-L
Wye
N

Balanced system considerations

In situations where you are monitoring a balanced 3-phase load, you may choose
to connect only one or two CTs on the phase(s) you want to measure, and then
configure the meter so it calculates the current on the unconnected current
input(s).

NOTE: For a balanced 4-wire Wye system, the meter’s calculations assume
that there is no current flowing through the neutral conductor.

EAV15107-EN0O5
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Balanced 3-phase Wye system with 2 CTs

The current for the unconnected current input is calculated so that the vector sum
for all three phases equal zero.

Balanced 3-phase Wye or Delta system with 1CT

The currents for the unconnected current inputs are calculated so that their
magnitude and phase angle are identical and equally distributed, and the vector
sum for all three phase currents equal zero.

NOTE: You must always use 3 CTs for 3-phase 4-wire center-tapped Delta or
center-tapped open Delta systems.

Communications connections

RS-485 wiring

Connect the devices on the RS-485 bus in a point-to-point configuration, with the
(+) and (-) terminals from one device connected to the corresponding (+) and (-)
terminals on the next device.

RS-485 cable

Use a shielded 2 twisted pair or 1.5 twisted pair RS-485 cable to wire the devices.
Use one twisted pair to connect the (+) and (-) terminals, and use the other
insulated wire to connect the C terminals

The total distance for devices connected on an RS-485 bus should not exceed
1200 m (4000 ft).

RS-485 terminals

C Common. This provides the voltage reference (zero volts) for the data plus and data minus
signals

Shield. Connect the bare wire to this terminal to help suppress signal noise that may be
present. Ground the shield wiring at one end only (either at the master or the last slave
@ device, but not both.

- Data minus. This transmits/receives the inverting data signals.

+ Data plus. This transmits/receives the non-inverting data signals.

NOTE: If some devices in your RS-485 network do not have the C terminal,
use the bare wire in the RS-485 cable to connect the C terminal from the
meter to the shield terminal on the devices that do not have the C terminal.

Ethernet communications connections

Use a shielded Ethernet cable to connect the meter’s Ethernet port.

Ground terminal is not available on the meter; shield should be connected to
ground at the other end. Your Ethernet connection source should be installed in a
location that minimizes the overall Ethernet cable routing length.

18 EAV15107-ENO5
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Display

Display overview

The display lets you use the meter to perform various tasks such as setting up the
meter, displaying data screens, acknowledging alarms, or performing resets.

Power Susten

UT Connect

3PH4W Wye Unand

A | Navigation / menu selection
buttons

LED (green)

B | Heartbeat / communications

C | Alarm/energy pulsing LED
(orange)

options

D | Navigation symbols or menu

E | Right notification area

F | Screen title

Left notification area

Cursor

Notification icons

To alert you about meter state or events, notification icons appear at the top left or
top right corner of the display screen.

Icon

Description

4

The wrench icon indicates that the power meter requires
maintenance.

The alarm icon indicates an alarm condition has occurred.

The blinking heartbeat icon indicates that the power meter is in
normal operating condition.

Meter display language

You can configure the meter to display the information on the display screen in

one of several languages.

The following languages are available:

English
French
Spanish
German
Italian
Portuguese
Russian
Chinese

EAV15107-EN0O5

19



PowerLogic™ PM5300 series Display

Meter screen navigation

The meter’s buttons and display screen allow you to navigate data and setup
screens, and to configure the meter’s setup parameters.

A. Press the button below the
appropriate menu to view
that screen

_EETETEE BN N EEETETTE

Fauwer Systen T Secandary 6 B. Press the right arrow to
ZPH4W Wye Ungnd 5 Vview more screens

UT Connect Sys Frequency (Hz) C. In setup mode, a small
2ut 66 right arrow indicates the
UT Prinary (U3 PFhase Rotation selected option

D. Insetup mode, a small
down arrow indicates that
there are additional
parameters to display. The
down arrow disappears
when there are no more
parameters to display.

E. In setup mode, press the
button under Edit to
change that setting. If the
item is read-only, cannot
be configured with the
meter’s existing setup, or
can only be configured
using software, Edit
disappears.

Navigation symbols

Navigation symbols indicate the functions of the associated buttons on your
meter’s display.

Symbol Description Actions

Right arrow Scroll right and display more menu items or move cursor
| 3 one character to the right

Up arrow Exit screen and go up one level
A

Small down Move cursor down the list of options or display more items
v arrow below

Small up arrow Move cursor up the list of items or display more items
A above

Left arrow Move cursor one character to the left
|

Plus sign Increase the highlighted value or show the next item in the
+ list.

Minus sign Show the previous item in the list

When you reach the last screen, press the right arrow again to cycle through the
screen menus.

Meter screen menus overview

All meter screens are grouped logically, according to their function.

You can access any available meter screen by first selecting the Level 1 (top level)
screen that contains it.

Level 1 screen menus - IEEE title [IEC title]

[Amps [T Volts [U-V] |»[Power [PQS]}|> Energy [E] |b{ PF | Hz[F] |»| THD |‘1
"’ L~| Harm P Unbal P MnMx Jo{ Alarm | 10 ][ Timer | QR |+ Maint || Clock |—|
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Menu tree

Use the menu tree to navigate to the parameter or setting you want to view or
configure.

Level 1, 2 and 3 meter screens - IEEE title [IEC title]

The image below summarizes the available meter screens (IEEE menus shown,
with the corresponding IEC menus in parentheses).
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Level 1 Level 2 Level 3

Amps

01 ps [I]

Power [PQS]
oiee Active [P] [Reac[Q] | Appr(S] |

Dmd Wd[Pd] | » Wd[Pd] | PkDT
VARd [Qd]| | VARd [Qd] | Pk DT
i:VAd [Sd] || vad[Sd] | PkDT
QR

Energy
[E]

T1 | 12] T3] T4

Amps[l] [ VL-L[U] | VL-N[V] |
Amps[l] [ VL-L[U] | VL-N[V] |

V L-L [U]
V L-N [V]
Amps [I]
TDD

VL-L[U [VLNV]
Power [PQ Active [P] | Reac [Q] | Appr[S] ]
= True Disp |

5 THD  [tdh
ba Amps [I] [V L-L[U] VLN [V])

Active
Hist
Count

Unack

Meter Basic Advan Dmd Tariff |
+{ Comm
Alarm 1-Sec Unary Dig
110 LED Dln D Out Relay |
HMI Displ Region Pass
b{ Clock
.
+{ Meter
Cl Pwr
PhAng
b QR

Clock
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Data display screens

The meter display screens allow you to view meter values and configure settings.

The titles listed are for the HMI mode in IEEE, with the corresponding titles in IEC
mode in square brackets [ ].

Current

Amps [1]

Bulleted items indicate subscreens and their descriptions.

Amps Per Phase

Instantaneous current measurements for each phase and neutral.

Dmd Summary of peak current demand values at the last demand interval.
+ lavg * Real-time demand (Pres), peak demand (Peak) and predicted demand (Pred) for the
. PKDT present interval. Average demand for the previous (Last) interval.
» Date and timestamp for the peak demand readings.
Ig Average (lavg), neutral (In) and residual/ground (Ig) current
Voltage
Volts [U-V]

Voltage L-L [U]

Line-to-line voltage for each phase.

Voltage L-N [V]

Line-to-neutral voltage for each phase.

Harmonics

Harm

Harmonics %

Graphical representation of harmonics (as a percent of fundamental).

VL-L[U]
* Fundamental, 3-11, 13-21, 23-31

Line-to-line voltage harmonics data: Numeric magnitude and angle for the fundamental
harmonic, and graphical representation of harmonics for the 3rd to 11th, 13th to 21st, and 23rd
to 31st odd harmonics for each line-to-line phase voltage.

VL-N[V]
e Fundamental, 3-11, 13-21, 23-31

Line-to-neutral voltage harmonics data: Numeric magnitude and angle for the fundamental
harmonic, and graphical representation of harmonics for the 3rd to 11th, 13th to 21st, and 23rd
to 31st odd harmonics for each line-to-neutral phase voltage.

Amps [1]
* Fundamental, 3-11, 13-21, 23-31

Current harmonics data: Numeric magnitude and angle for the fundamental harmonics, and
graphical representation of harmonics for the 3rd to 11th, 13th to 21st, and 23rd to 31st odd
harmonics for each phase current.

TDD

Total demand distortion each phase voltage.
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Power

Power [PQS]

Power Summary

Summary of real-time power consumption values for total active power in kW (Total [Ptot]), total
reactive power in kVAR (Total [Qtot]), and total apparent power in kVA (Total [Stot]).

Phase
« Active [P], Reac [Q], Appr [S]

Per phase (A [P1], B [P2], C [P3]) and total (Total [Ptot]) power values for active power in kW,
reactive power in kVAR and apparent power in kVA.

Pwr Dmd Summary
+ Wd [Pd], VARd [Qd], VAd [Sd]
+  Tot,A[1],B[2], C[3]

Summary of peak power demand values in the previous (Last) demand interval period for active
power in kW, reactive power in kVAR and apparent power in kVA.

» Total and per phase peak power demand values in the previous (Last) demand interval for
active power demand (Wd [P]), reactive power demand (VARd [Q]) and apparent power

 PkDT demand (VAd [S]).
* For the selected power demand screen (active, reactive or apparent), each of these sub-
screens (total and per phase demand) displays demand values for the present demand
(Pres) interval, predicted demand (Pred) based on the current power consumption rate,
demand for the previous demand (Last) interval period, and the recorded peak power
demand (Peak) value.
» Date and timestamp for the peak power demand (Peak) value.
Energy
Energy [E]
Wh, VAh, VAR Delivered (Del), received (Rec), delivered plus received (D+R) and delivered minus received (D-
R) accumulated values for active energy (Wh), apparent energy (VAh) and reactive energy
(VARNh).
Tariff « Displays the available tariffs (T1 through T4).
e T1,T2,T3, T4 « Active energy delivered in Wh (W [P]), reactive energy delivered in VAR (VAR [Q]) and
« Del apparent energy delivered in VAh (VA [S]) energy for the selected tariff.
. Rec » Active energy received in Wh (W [P]), reactive energy received in VARh (VAR [Q]) and

apparent energy received in VAh (VA [S]) energy for the selected tariff

Power Factor

PF

True Per phase and total true power factor values and sign.

Disp Per phase and total displacement power factor values and sign.
Frequency
Hz [F]

Frequency (Freq), average voltage (Vavg), average current (lavg) and total power factor (PF) values.

Total harmonic distortion

THD

THD
< Amps[l], VL-L[U], VL-N [V]

THD (ratio of harmonic content to the fundamental) for current, line-to-line voltage and line-to-
neutral voltage.

thd
< Amps[i], VL-L[U], VL-N[V]

thd (ratio of harmonic content to the rms value of total harmonic content) for current, line-to-line
voltage and line-to-neutral voltage.

24
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Unbalance

Unbal

Percent unbalance readings for line-to-line voltage (V L-L [U]), line-to-neutral voltage (V L-N [V]) and current (Amps [I]).

Minimum / maximum

MnMx

Max Summary
*  Amps]|l]
+  Volts [U-V]
* VL-L[U],VL-N[V]

Summary of maximum values for line-to-line voltage, line-to-neutral voltage, phase current and
total power.

*  Minimum and maximum values for phase current.
*  Minimum and maximum values for line-to-line voltage and line-to-neutral voltage.

Power [PQS]
» Active [P], Reac [Q], Appr [S]

Minimum and maximum values for active, reactive, and apparent power.

< Amps|[l], VL-L[UL VLN V]

PF Minimum and maximum values for true and displacement PF and PF sign.
+ True, Disp
Hz [F] Minimum and maximum values for frequency.
THD Minimum and maximum values for total harmonic distortion (THD or thd).
+ THD, thd *  THD or thd minimum and maximum values for phase or neutral current, line-to-line voltage

and line-to-neutral voltage.

Unbal
«  Amps]|l], VL-L[U],VL-N[V]

Minimum and maximum values for current unbalance, line-to-line voltage unbalance and line-to-
neutral voltage unbalance.

Alarm

Alarm

Active, Hist, Count, Unack

Lists all active alarms (Active), past alarms (Hist), the total number of times each standard alarm
was tripped (Count), and all unacknowledged alarms (Unack).

Input / output

/10

D Out, S In, Relay

Current status (on or off) of the selected digital output, status input or relay. Counter shows the
total number of times an off-to-on change of state is detected. Timer shows the total time (in
seconds) that a digital output, status input or relay is in the on state.

Timer
Timer
Load Real-time counter that keeps track of the total number of days, hours, minutes and seconds an
active load is connected to the meter inputs.
Oper Real-time counter for the total number of days, hours, minutes and seconds the meter has been

powered.
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Maintenance

Maint
Reset Screens to perform global or single resets.
Setup Meter configuration screens.

Clock
Basic, Advan, Dmd, Tariff

Meter, Comm, Alarm, /O, HMI,

Diag Diagnostic screens provide meter information, status and event data for troubleshooting. The
Info, Meter, Cl Pwr, PhAng PhAnNg screen displays a graphical representation of the power system the meter is monitoring.
Clock
Clock

Meter date and time (local or GMT).

HMI setup screens

Setting up the display

You can configure the meter’s display using the HMI setup screens.

The HMI (human-machine interface) setup screens allow you to:

control the general appearance and behavior of the display screens,
change the regional settings,

change the meter passwords,

enable or disable the QR code feature for accessing meter data.

See the Meter Insights QR code feature quick start guide for more information on
accessing meter data using QR codes.

You can change the display screen’s settings, such as contrast, display and
backlight timeout and QR code display.

A w0 N

o

Navigate to Maint > Setup.
Enter the setup password (default is “0”), then press OK.
Navigate to HMI > Disp.

Move the cursor to point to the parameter you want to modify, then press
Edit.

Modify the parameter as required, then press OK.

Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

Press the up arrow to exit.

26
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8. Press Yes to save your changes.

Display settings available using the display

Parameter Values Description

Contrast 1-9 Increase or decrease the value to increase or decrease
the display contrast.

Bcklight Timeout | 0-99 Set how long (in minutes) before the backlight turns off

(min) after a period of inactivity. Setting this to “0” disables
the backlight timeout feature (i.e., backlight is always
on).

Screen Timeout | 0-99 Set how long (in minutes) before the screen turns off

(min)

after a period of inactivity. Setting this to “0” disables
the screen timeout feature (i.e., display is always on).

QR Code

Enable, Disable

Set whether or not QR codes with embedded data are
available on the display.

See the Meter Insights QR code feature quick start guide for more information
on accessing meter data using QR codes.

To configure the display using ION Setup, see the section for your meter in
the ION Setup online help or in the ION Setup device configuration guide,
available for download at www.schneider-electric.com.
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Basic setup

Meter configuration can be performed directly through the display or remotely
through software. See the section on a feature for instructions on configuring that
feature (for example, see the Communications section for instructions on
configuring Ethernet communications).

Configuring basic setup parameters using the display

You can configure basic meter parameters using the display.

Proper configuration of the meter’s basic setup parameters is essential for
accurate measurement and calculations. Use the Basic Setup screen to define the
electrical power system that the meter is monitoring.

If standard (1-sec) alarms have been configured and you make subsequent
changes to the meter’s basic setup, all alarms are disabled to prevent undesired
alarm operation.

NOTICE

UNINTENDED EQUIPMENT OPERATION

» Verify all standard alarms settings are correct and make adjustments as
necessary.

* Re-enable all configured alarms.

Failure to follow these instructions can result in equipment damage.

After saving the changes, confirm all configured standard alarm settings are still
valid, reconfigure them as required, and re-enable the alarms.

1. Navigate to Maint > Setup.
Enter the setup password (default is “0”), then press OK.

Navigate to Meter > Basic.

A w0 N

Move the cursor to point to the parameter you want to modify, then press
Edit.

o

Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.
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7. Press the up arrow to exit, then press Yes to save your changes.

Basic setup parameters available using the display

Values

Description

Power System

Select the power system type (power transformer) the meter is wired to.

1PH2W LN

Single-phase 2-wire line-to-neutral

1PH2W LL

Single-phase 2-wire line-to-line

1PH3W LL with N

Single-phase 3-wire line-to-line with neutral

3PH3W DIt Ungnd

3-phase 3-wire ungrounded delta

3PH3W DIt Crnr Gnd

3-phase 3-wire corner grounded delta

3PH3W Wye Ungnd

3-phase 3-wire ungrounded wye

3PH3W Wye Gnd

3-phase 3-wire grounded wye

3PH3W Wye Res Gnd

3-phase 3-wire resistance-grounded wye

3PH4W Opn DIt Ctr Tp

3-phase 4-wire center-tapped open delta

3PH4W DIt Ctr Tp 3-phase 4-wire center-tapped delta
3PH4W Wye Ungnd 3-phase 4-wire ungrounded wye
3PH4W Wye Gnd 3-phase 4-wire grounded wye

3PH4W Wye Res Gnd

3-phase 4-wire resistance-grounded wye

VT Connect

Select how many voltage transformers (VT) are connected to the electrical power system.

Direct Con Direct connect; no VTs used
2VT 2 voltage transformers

3VT 3 voltage transformers

VT Primary (V)

1to 1,000,000

Enter the size of the VT primary, in Volts.

VT Secondary (V)

100, 110, 115, 120

Select the size of the VT secondary, in Volts.

CT on Terminal

Define how many current transformers (CT) are connected to the meter, and which terminals they are connected to.

1 CT connected to 11 terminal

12 1 CT connected to |12 terminal

13 1 CT connected to I3 terminal

1112 2 CTconnected to I1, 12 terminals

1113 2 CT connected to I1, 13 terminals

1213 2 CTconnected to 12, 13 terminals

111213 3 CT connected to 11, 12, I3 terminals

CT Primary (A)

1to 32767 Enter the size of the CT primary, in Amps.
CT Secondary (A)

1,5 Select the size of the CT secondary, in Amps.

CT Primary Neu. (A)

1to 32767

This parameter displays when CT on Terminal is set to 11,12,13, IN. Enter the size of the 4th
(Neutral) CT primary, in Amps.

CT Sec. Neu. (A)
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Values Description

1,5 This parameter displays when CT on Terminal is set to 11,12,13, IN. Select the size of the 4th
(Neutral) CT secondary, in Amps.

Sys Frequency (Hz)

50, 60 Select the frequency of the electrical power system, in Hz.

Phase Rotation

ABC, CBA Select the phase rotation of the 3-phase system.

Configuring advanced setup parameters using the display

You can configure a subset of advanced parameters using the display.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0”), then press OK.
3. Navigate to Meter > Advan.
4

. Move the cursor to point to the parameter you want to modify, then press
Edit.

o

Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

7. Press Yes to save your changes.

Advanced setup parameters available using the display

Parameter Values Description

Label — This label identifies the device, e.g., “Power Meter”.
You cannot use the display to edit this parameter. Use
ION Setup to change the device label.

Load Timer 0-18 Specifies the minimum average current at the load
Setpt (A) before the timer starts. The meter begins counting the
number of seconds the load timer is on (i.e., whenever
the readings are equal to or above this average current

threshold.
Pk I dmd for 0-18 Specifies the minimum peak current demand at the
TDD (A) load for inclusion in total demand distortion (TDD)

calculations. If the load current is below the minimum
peak current demand threshold, the meter does not
use the readings to calculate TDD. Set this to “0” (zero)
if you want the power meter to use the metered peak
current demand for this calculation.

Setting up regional settings

You can change the regional settings to localize the meter screens and display
data in a different language, using local standards and conventions.

NOTE: In order to display a different language other than those listed in the
Language setup parameter, you need to download the appropriate language
file to the meter using the firmware upgrade process.

1. Navigate to Maint > Setup.
2. Enter the setup password (default is “0”), then press OK.
3. Navigate to HMI > Region.
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4. Move the cursor to point to the parameter you want to modify, then press
Edit.

5. Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

7. Press the up arrow to exit.

8. Press Yes to save your changes.

Regional settings available using the display

Parameter Values Description
Language English US, Select the language you want the meter to display.
French,
Spanish,
German, Italian,
Portuguese,
Chinese,
Russian
Date Format MM/DD/YY, YY/ | Set how you want the date to be displayed, e.g., month/
MM/DD, DD/ daylyear.
MM/YY
Time Format 24Hr, AM/PM Set how you want the time to be displayed, e.g.,
17:00:00 or 5:00:00 PM.
HMI Mode IEC, IEEE Select the standards convention used to display menu
names or meter data.

Setting up the screen passwords

It is recommended that you change the default password in order to prevent
unauthorized personnel from accessing password-protected screens such as the
diagnostics and reset screens.

This can only be configured through the front panel. The factory-default setting for
all passwords is “0” (zero).

If you lose your password, you must return the meter for factory reconfiguration,
which resets your device to its factory defaults and destroys all logged data.

NOTICE

IRRECOVERABLE PASSWORD
Record your device's user and password information in a secure location.

Failure to follow these instructions can result in data loss.

1. Navigate to Maint > Setup.
Enter the setup password (default is “0”), then press OK.

Navigate to HMI > Pass.

owDN

Move the cursor to point to the parameter you want to modify, then press
Edit.

o

Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

7. Press the up arrow to exit.
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8. Press Yes to save your changes.

Parameter Values Description

Setup 0000 - 9999 Sets the password for accessing the meter setup
screens (Maint > Setup).

Energy Resets 0000 - 9999 Sets the password for resetting the meter’s
accumulated energy values.

Demand Resets | 0000 - 9999 Sets the password for resetting the meter’s recorded
peak demand values.

Min/Max Resets | 0000 - 9999 Sets the password for resetting the meter’s recorded
minimum and maximum values.

Diagnostics 0000 - 9999 Sets the password for accessing the meter’s
diagnostics screens.

Lost user access

Setting the clock

If you lose your meter’s user access (password) information, contact your local
Schneider Electric representative for instructions on how to return your meter for
factory reconfiguration.

NOTE: Have your meter’s serial number available for reference.

The Clock setup screens allow you to set the meter’s date and time.

NOTE: You must always set or sync the meter time to UTC (GMT, Greenwich
Mean Time), not local time. Use the GMT Offset (h) setup parameter to
display the correct local time on the meter.

1. Navigate to Maint > Setup.
Enter the setup password (default is “0”), then press OK.

Navigate to Clock.

A w0 N

Move the cursor to point to the parameter you want to modify, then press
Edit.

o

Modify the parameter as required, then press OK.

6. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

7. Press the up arrow to exit.
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8. Press Yes to save your changes.

Parameter Values Description
Date DD/MM/YY, Set the current date using the format displayed on
MM/DD/YY, YY/ | screen, where DD = day, MM = month and YY = year.
MM/DD
Time HH:MM:SS (24 Use the 24-hour format to set the current time in UTC
hour format), (GMT).
HH:MM:SS AM
or PM
Meter Time GMT, Local Select GMT to display the current time in UTC
(Greenwich Mean Time zone). To display local time, set
this parameter to Local, then use GMT Offset (h) to
display local time in the proper time zone.
GMT Offset (h) ' | £ HH.0 Available only when Meter Time is set to Local, use this

to display the local time relative to GMT. Set the sign to
plus (+) if local time is ahead of GMT, or minus (-) if
local time is behind GMT.

1. Currently supports whole integers only.

To configure the clock using ION Setup, see the section for your meter in the
ION Setup online help or in the ION Setup device configuration guide,
available for download at www.schneider-electric.com.
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Communications

Serial communications

The meter supports serial communication through the RS-485 port.

In an RS-485 network, there is one master device, typically an Ethernet to RS-485
gateway. It provides the means for RS-485 communications with multiple slave
devices (for example, meters). For applications that require only one dedicated
computer to communicate with the slave devices, a USB to RS-485 converter can
be used to connect to the master device.

Up to 32 devices can be connected on a single RS-485 bus.

RS-485 network configuration

RS-485 port setup

After you have wired the RS-485 port and powered up the meter, you must
configure the serial communications port in order to communicate with the meter.

Each device on the same RS-485 communications bus must have a unique
address and all connected devices must be set to the same protocol, baud rate,
and parity (data format).

NOTE: To communicate with the meter using ION Setup, you must set the
serial site and all connected devices in the RS-485 network to the same parity
setting.

For meters that do not have a display, you must first wire and configure each one
separately before connecting these meters to the same RS-485 bus.

The meter is factory-configured with default serial communications settings that
you may need to modify before connecting the meter to the RS-485 bus.

The meter is factory-configured with the following default serial communications
settings:

* Protocol = Modbus RTU
» Address =1

+ Baud rate = 19200

+ Parity = Even

You can use a communications converter (USB to RS-485 or RS-232 to RS-485)
or Ethernet gateway device to connect to the meter.

NOTE: Your meter’s serial communications port ID (Com1 ID) is used in both
Ethernet and serial communications; you need to change the Com1 ID meter
property in ION Setup if you modify the meter’s RS-485 address.

Setting up serial communications using the display

The Serial Port setup screen allows you to configure the meter’s RS-485
communications port so you can use software to access the meter’s data or
configure the meter remotely.

1. Navigate to Maint > Setup.
Enter the setup password (default is “0000”), then press OK.

Press Comm.

A w N

Move the cursor to point to the parameter you want to modify, then press
Edit.

5. Modify the parameter as required, then press OK.
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6. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

7. Press the up arrow to exit. Press Yes to save your changes.

Parameter Values Description

Protocol Modbus Select the communications format used to transmit
data. The protocol must be the same for all devices in a
communications loop.

Address 1to 247 Set the address for this device. The address must be
unique for each device in a communications loop. For
Jbus protocol, set the device ID to 255.

Baud Rate 9600, 19200, Select the speed for data transmission. The baud rate
38400 must be the same for all devices in a communications
loop
Parity Even, Odd, Select None if the parity bit is not used. The parity
None setting must be the same for all devices in a

communications loop.

Ethernet communications

Ethernet configuration

Ethernet port setup

The meter uses Modbus TCP and BACnet/IP protocols to communicate at data
speeds up to 100 Mbps through its Ethernet communications port (if available).

The meter supports a maximum of 128 concurrent TCP/IP connections. A
maximum of 20 HTTP connections are supported.

In order to use Ethernet communications, you must configure your device’s IP
address; you must also configure the subnet and gateway information if required
by your network.

NOTE: For meters that do not have a display, you must configure each one
separately in order to set a unique IP address for each device.

You need to enter network information for any Ethernet servers used by the
device.

NOTE: Contact your network system administrator for your IP address and
other Ethernet network configuration values.

Configure your device’s Ethernet settings by using the display or directly
connecting to your meter and using a web browser to access the device’s
webpages. Modify your meter’s Ethernet settings to those provided by your
network system administrator before connecting the device to your local area
network (LAN).

After the meter’s Ethernet port is configured and connected to the LAN, you can
use ION Setup to configure other meter setup parameters.

The meter is factory-configured with default Ethernet communications settings.

You must modify the default Ethernet settings before connecting the meter to your
local area network (LAN) using the meter webpages.

The default Ethernet communications settings are:
+ |P address = 169.254.0.10
+ Subnet mask =255.255.0.0
+ Gateway =0.0.0.0

* Device name = PM53-#xxxxxxxxxX, where xxxxxxxxxx is the meter’s factory
serial number (with leading zeros if serial number is less than 10 characters)
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IP method = Default

NOTE: Your meter’s serial communications port ID (Com1 ID) is used in both
Ethernet and serial communications; you need to change the Com1 ID meter
property in ION Setup if you modify the meter’s RS-485 address.

Setting up Ethernet communications using the display

The Ethernet setup screen allows you to assign the meter a unique IP address so
you can use software to access the meter’s data or configure the meter remotely
through the Ethernet port.

Before configuring the Ethernet parameters, make sure you obtain your meter’s IP
address information from your network administrator or IT department.

A w0 N

o

. Navigate to Maint > Setup.

Enter the setup password (default is “0000”), then press OK.

Press Comm.

Move the cursor to point to the parameter you want to modify, then press

Edit.

Modify the parameter as required, then press OK.

Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

Press the up arrow to exit.

Press Yes to save your changes.

Parameter Values Description
IP Method Stored, Default, | This controls the network protocol for your device (what
DHCP, BOOTP | the meter uses to obtain its IP address).
Stored: Use the static value programmed in the IP
Address setup register
Default: Use 169.254 as the first two values of the IP
address, then convert the last two hexadecimal values
of the MAC address to decimal and use this as the last
two values of the IP address. Example:
MAC address = 00:80:67:82:B8:C8
Default IP = 169.254.184.200
DHCP: Dynamic Host Configuration Protocol
BOOTP: Bootstrap Protocol
IP Address Contact your The Internet protocol address of your device.
local network
administrator for
parameter
values.
Subnet Contact your The Ethernet IP subnetwork address of your network
local network (subnet mask).
administrator for
parameter
values.
Gateway Contact your The Ethernet IP gateway address of your network.
local network
administrator for
parameter
values.
HTTP Server Disabled Controls whether your device’s webserver and
webpages are active or not.
Device Name N/A This parameter is read-only for reference purposes.
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BACnet/IP

BACnet/IP protocol allows communication between the components of a building
automation and control system (for example, HVAC, lighting control, security
systems and related equipment).

The BACnet/IP protocol defines a number of services that are used to
communicate between devices and the objects that are acted upon by those
services.

Term Definition

APDU Application protocol data unit, that data portion of a BACnet
message.

Confirmed message A message for which the device expects an answer.

COV, COV increment Change of value, sets the amount by which a value has to change in

order for the meter to send a subscription notification.

Device A BACnet device is a unit that is designed to understand and use
BACnet protocol (for example, a BACnet-enabled meter or software
program). It contains information about the device and device data in
objects and object properties. Your meter is a BACnet device.

Object Represents the device and device data. Each object has a type (for
example, analog input or binary input) and has a number of
properties.

Present value The current value of an object.

Property The smallest piece of information in BACnet communications, it

consists of a name, data type and value.

Service Messages from one BACnet device to another.

Subscription A relationship between a BACnet client and the meter, so that when
the present value property of an object changes on the meter, a
notification is sent to the client.

Subscription notification The message the meter sends to indicate a COV event has occurred.

Unconfirmed message A message for which the device does not expect an answer.

BACnet Broadcast A BACnet/IP device (or software application) residing on a BACnet/

Management Device IP subnet that forwards BACnet broadcast messages from devices

(BBMD) on its subnet to peer BBMDs and registered foreign devices on other
subnets.

Foreign device A BACnet/IP device (or software application) that resides on a

remote IP subnet and registers with a BBMD to facilitate the sending
and receiving of broadcast messages to/from devices accessible by
the BBMD.

Supported BACnet features

PM5320, PM5340 and PM5341 meters support specific BACnet components and
standard objects over Ethernet. The supported BACnet features are available in
applicable products with firmware version 2.00 and above.

The meter’s BACnet/IP protocol support is certified by BACnet International. Go to
www.bacnetinternational.org or www.schneider-electric.com and search for your
meter model to access the PICS (Protocol Implementation Conformance
Statement) for your meter.

Supported BACnet components

BACnet component Description
Protocol version 1
Protocol revision 14
Standardized device profile (Annex L) BACnet Application Specific Controller (B-ASC)
BACNet Interoperability Building Blocks (Annex K) * DS-RP-B (Data Sharing - Read Property - B)
» DS-RPM-B (Data Sharing - Read Property Multiple - B)
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BACnet component

Description

DS-WP-B (Data Sharing - Write Property - B)

DS-WPM-B (Data Sharing - Write Property Multiple - B)

DS-COV-B (Data Sharing - COV - B)

DM-DDB-B (Device Management - Dynamic Device Binding - B)
DM-DOB-B (Device Management - Dynamic Object Binding - B)
DM-DCC-B (Device Management - Device Communication Control - B)

BACnet/IP (Annex J)

BACnet communication internet protocol

Data link layer options

UDP

Character set ANSI

X3.4/UTF-8

Supported services

subscribeCOV

readProperty
readPropertyMultiple
writeProperty
writePropertyMultiple
deviceCommunicationControl
who-HAS

who-Is

I-Am

I-Have

Confirmed COV notification
Unconfirmed COV notification

Segmentation

The meter does not support segmentation

Static device address binding

The meter does not support static device address binding

Networking options

The meter supports registration as a foreign device

Supported standard object types

NOTE: The BACnet protocol allows you to set the out-of-service property of
an object to true and write a value to that property for testing purposes. In this
case, your BACnet software displays the value you wrote to the object, not the
actual value from the meter and the system it is monitoring. Make sure you set
the out-of-service property of all objects to false before you put the meter into

service.
Object type Optional properties Writeable properties Conditional writeable
supported supported properties supported

Device Object * Location *  Object_Name —

+  Description *  Object_ldentifier

* Local_Time * Location

* Local_Date «  Description

+ Active_COV_ + APDU_Timeout

Subscriptions

Profile_Name

*  Number_Of APDU_
Retries

Analog Input Object

Description
Reliability
COV_Increment

* Out_Of Service
+ COV_Increment

Present_Value

Binary Input Object » Description Out_Of_Service Present_Value
* Reliability

Multi-state Input Object » Description Out_Of_Service Present_Value
* Reliability
+ State_Text
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BACnet/IP communications implementation

Your meter's BACnet implementation includes specific behaviors and
configuration.

Basic configuration for BAChet communications

Before communicating with the meter via BACnet protocol, make sure the basic
BACnet settings are configured appropriately for your network. The Device ID

must be unique in your BACnet IP network.

Change of Value (COV) subscriptions

The meter supports up to 20 COV subscriptions. You can add COV subscriptions
to Analog Input, Binary Input and Multi-state Input objects using your BACnet-

compatible software.

Configuring BACnet/IP settings using the display

Use the meter’s display to configure BACnet/IP settings if required.

—_

D O

. Navigate to Maint > Setup.

Edit.

Navigate to Comm > BACnet.

. Enter the setup password then press OK.

. Move the cursor to point to the parameter you want to modify, then press

. Modify the parameter as required, then press OK.

. Move the cursor to point to the next parameter you want to modify, press Edit,

make your changes, then press OK.

. Press the up arrow to exit.

Basic BACnet/IP settings available using the display

Parameter

Values

Description

BACnet Status

Enabled, Disabled

Enable or disable BACnet/IP communications
with the meter

Device ID

0—-4194302

Enter the ID of the meter on your BACnet
network. The ID must be unique on the
network.

UDP Port

1024 — 65535

Enter the port the meter uses for BACnet/IP
communications. The default is the standard
BACnet/IP port (47808).

Foreign device settings available using the display

Parameter

Values

Description

BBMD Status

Enabled, Disabled

Enable or disabled registration of the meter
as a foreign device.

BBMD IP Contact your local Enter the IP address of the BACnet/IP
network Broadcast Management Device (BBMD), if
administrator for you use a BBMD on your network.
parameter values.

BBMD Port 1024 — 65535 Enter the port number that is used for

communications with the BBMD. The default
is the standard BACnet/IP port (47808)
BBMD TTL (sec) 0-65535 The length of time (in seconds) the BBMD

keeps an entry for this device in its foreign
device table.
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BACnet objects
Device object
Your meter has a Device object which describes the meter to the BACnet network.
The following table outlines the properties of the Device object, whether a property
is read-only or read-write, and if the value of the property is stored in the meter’s
nonvolatile onboard memory.

Device object property R/W Stored Possible values Description

Object_Identifier R/W Y See description The unique device ID number for the meter, in
the format of <device, #>.

The meter ships from the factory with a device
ID equal to the last 6 digits of the serial
number.

Object_Name R/W Y See description A configurable name for the meter.

The meter ships from the factory with a name
of <model name> <serial number> (for
example, PM5320_0000000000).

Object_Type R — Device The object type for the meter.

System_Status R — Operational This value of this property is always
Operational.

Vendor_Name R — Schneider Electric Meter manufacturer

Vendor_|dentifier R — 10 The BACnet vendor identifier for Schneider
Electric.

Model_Name R — varies Device model (for example, PM5320) and
serial number in the format <model name>
<serial number> (for example, PM5320_
0000000000).

Firmware_Revision R — varies BACnet firmware version, stored in an x.x.x
format (for example, 1.9.0).

Application_Software_Version R — varies Meter firmware version, stored in an x.x.x
format (for example, 1.0.305).

Description R/W Y configurable Optional description of the meter, limited to 64
characters.

Location R/W Y configurable Optional description of the meter’s location,
limited to 64 characters.

Protocol_Version R — varies BACnet protocol version (for example, version
1)

Protocol_Revision R — varies BACnet protocol revision (for example,
revision 14)

Protocol_Services_Supported R — 0000 0100 0000 1011 The BACnet services supported by the meter:

1100 1000 0000 0000 subscribeCQOV, readProperty,

0110 0000 0 readPropertyMultiple, writeProperty,
writePropertyMultiple,
deviceCommunicationControl,
ReinitializeDevice, who-HAS, who-Is

Protocol_Object_Types_ R — 1001 0000 1000 0100 The BACnet object types supported by the

Supported 0000 0000 0000 0000 meter: analog input, binary input, multi-state

0000 0000 0000 0000 input, device.

0000 000

Object_list R — See description List of objects in the meter.

Max_APDU_Length_Accepted R — 1476 The maximum packet size (or application
protocol data unit) that the meter can accept,
in bytes.

Segmentation_Supported R — 0x03 The meter does not support segmentation.

Local_Date R — varies Current date on the meter

NOTE: Use the display, the webpages or
ION Setup to set the meter’s date.
Local_Time R — varies Current time on the meter
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Device object property R/W Stored Possible values Description

NOTE: Use the display, the webpages or
ION Setup to set the meter’s time. You
can also set up SNTP time
synchronization using the webpages.

APDU_Timeout R/W Y 1000 — 30000 The amount of time (in milliseconds) before
the meter tries to resend a confirmed message
that has not been answered.

Number_Of_APDU_Retries R/W Y 1-10 The number of times the meter tries to resend
an unanswered confirmed request.

Device_Address_Binding R — — Device address binding table is always blank
because the meter does not initiate the who-Is
service.

Database_Revision R Y varies A number that increments when the object

database on the meter changes (for example,
when an object is created or deleted or the ID
of an object changes).

Active_COV_Subscriptions R — varies List of COV subscriptions currently active on
the meter.
Profile_Name R — varies Device identifier that records the meter

manufacturer, the meter family and the
specific meter model (for example, 10-
PM5000-PM5320).

Analog Input objects

Your meter has a number of Analog Input objects that provide meter values and
information on meter settings.

The following tables list the Analog Input objects along with the units and default
COV value for each object (if applicable).

Real-time measurements

Object ID Object name Units Default Description
cov
3000 Current-Ph A A 50 Current phase A
3002 Current-Ph B A 50 Current phase B
3004 Current-Ph C A 50 Current phase C
3006 Current - Neutral A 50 Neutral current
3008 Current - Ground A 50 Ground current
3010 Current - Avg A 50 Current average
3012 CurrentUnb - Ph A % 20 Current unbalance
phase A
3014 Current Unb - Ph B % 20 Current unbalance
phase B
3016 CurrentUnb - Ph C % 20 Current unbalance
phase C
3018 Current Unb - Worst % 20 Current unbalance worst
3020 Voltage - A-B V 10 Voltage A-B
3022 Voltage - B-C \% 10 Voltage B-C
3024 Voltage - C-A \% 10 Voltage C-A
3026 Voltage - Avg L-L \% 10 Voltage L-L Avg
3028 Voltage - A-N \% 10 Voltage A-N
3030 Voltage - B-N \Y 10 Voltage B-N
3032 Voltage - C-N \Y 10 Voltage C-N
3036 Voltage - Avg L-N \Y 10 Voltage L-N Avg
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Object ID Object name Units Default Description
cov
3038 Voltage Unb - A-B % 20 Voltage unbalance A-B
3040 Voltage Unb - B-C % 20 Voltage unbalance B-C
3042 Voltage Unb - C-A % 20 Voltage unbalance C-A
3044 Voltage Unb - Worst L-L % 20 Voltage unbalance L-L
worst
3046 Voltage Unb - A-N % 20 Voltage unbalance A-N
3048 Voltage Unb - B-N % 20 Voltage unbalance B-N
3050 Voltage Unb - C-N % 20 Voltage unbalance C-N
3052 Voltage Unb - WorstL-N | % 20 Voltage unbalance L-N
worst
3110 Frequency Hz 10 Frequency
Power and power factor
Object ID Object name Units Default Description
cov
3054 Active Power - Ph A kW 10 Active power phase A
3056 Active Power - Ph B kW 10 Active power phase B
3058 Active Power - Ph C kW 10 Active power phase C
3060 Active Power - Total kW 10 Active power total
3062 Reactive Power - Ph A kVAR 10 Reactive power phase A
3064 Reactive Power - Ph B kVAR 10 Reactive power phase B
3066 Reactive Power - Ph C kVAR 10 Reactive power phase C
3068 Reactive Power - Total kVAR 10 Reactive power total
3070 Apparent Power - Ph A kVA 10 Apparent power phase A
3072 Apparent Power - Ph B kVA 10 Apparent power phase B
3074 Apparent Power - Ph C kVA 10 Apparent power phase C
3076 Apparent Power - Total kVA 10 Apparent power total
3078 Power Factor - Ph A — 0.2 Power factor phase A
3080 Power Factor - Ph B — 0.2 Power factor phase B
3082 Power Factor - Ph C — 0.2 Power factor phase C
3084 Power Factor - Total — 0.2 Power Factor Total
Energy and energy by tariff measurements
Object ID Object name Units Default Description
cov
2700 Active Energy Delvd kWh 100 Active energy delivered
2702 Active Energy Revd kWh 100 Active energy received
2704 Active Energy Delvd + kWh 100 Active energy delivered
Revd + received
2706 Active Energy Delvd - kWh 100 Active energy delivered —
Revd received
2708 Reactive Energy Delvd kVARh 100 Reactive energy
delivered
2710 Reactive Energy Rcvd kVARh 100 Reactive energy
received
2712 Reactive Energy Delvd + | kVARh 100 Reactive energy

Rcvd

delivered + received
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Object ID Object name Units Default Description
cov
2714 Reactive Energy Delvd - | kVARh 100 Reactive energy
Rcvd delivered — received
2716 Apparent Energy Delvd kVAh 100 Apparent energy
delivered
2718 Apparent Energy Rcvd kVAh 100 Apparent energy
received
2720 Apparent Energy Delvd + | kVAh 100 Apparent energy
Revd delivered + received
2722 Apparent Energy Delvd - | kVAh 100 Apparent energy
Revd delivered — received
4191 Applicable Tariff Energy — 1 Denotes the active tariff:
Rate
0 = Multi Tariff feature is
disabled
1 = tariff 1 active
2 = tariff 2 active
3 = tariff 3 active
4 = tariff 4 active
4800 Active Energy Delvd kWh 100 Tariff 1 active energy
(Tariff 1) import
4802 Active Energy Delvd kWh 100 Tariff 2 active energy
(Tariff 2) import
4804 Active Energy Delvd kWh 100 Tariff 3 active energy
(Tariff 3) import
4806 Active Energy Delvd kWh 100 Tariff 4 active energy
(Tariff 4) import
Power demand
Object ID Object name Units Default Description
cov
3764 Dmd - Active Power Last | kW 10 Demand - Active power
last
3766 Dmd - Active Power kW 10 Demand - Active power
Present present
3768 Dmd - Active Power Pred | kW 10 Demand - Active power
predicted
3770 Dmd - Active Power kW 10 Demand - Active power
Peak peak
3780 Dmd - Reactive Power kVAR 10 Demand - Reactive
Last power last
3782 Dmd - Reactive Power kVAR 10 Demand - Reactive
Present power present
3784 Dmd - Reactive Power kVAR 10 Demand - Reactive
Pred power predicted
3786 Dmd - Reactive Power kVAR 10 Demand - Reactive
Peak power peak
3796 Dmd - Apparent Power kVA 10 Demand - Apparent
Last power last
3798 Dmd - Apparent Power kVA 10 Demand - Apparent
Present power present
3800 Dmd - Apparent Power kVA 10 Demand - Apparent
Pred power predicted
3802 Dmd - Apparent Power kVA 10 Demand - Apparent
Peak power peak
3972 Dmd - Active Power Ph A | kW 10 Demand - Active power

Last

phase A last
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Object ID Object name Units Default Description
cov
3974 Dmd - Active Power Ph A | kW 10 Demand - Active power
Present phase A present
3976 Dmd - Active Power Ph A | kW 10 Demand - Active power
Pred phase A predicted
3978 Dmd - Active Power Ph A | kW 10 Demand - Active power
Peak phase A peak
3988 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph A Last power phase A last
3990 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph A Present power phase A present
3992 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph A Pred power phase A predicted
3994 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph A Peak power phase A peak
4004 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph A Last power phase A last
4006 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph A Present power phase A present
4008 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph A Pred power phase A predicted
4010 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph A Peak power phase A peak
4020 Dmd - Active Power Ph B | kW 10 Demand - Active power
Last phase B last
4022 Dmd - Active Power Ph B | kW 10 Demand - Active power
Present phase B present
4024 Dmd - Active Power Ph B | kW 10 Demand - Active power
Pred phase B predicted
4026 Dmd - Active Power Ph B | kW 10 Demand - Active power
Peak phase B peak
4036 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph B Last power phase B last
4038 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph B Present power phase B present
4040 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph B Pred power phase B predicted
4042 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph B Peak power phase B peak
4052 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph B Last power phase B last
4054 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph B power phase B present
4056 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph B Pred power phase B predicted
4058 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph B Peak power phase B peak
4068 Dmd - Active Power Ph kW 10 Demand - Active power
C Last phase C last
4070 Dmd - Active Power Ph kW 10 Demand - Active power
C Present phase C present
4072 Dmd - Active Power Ph kW 10 Demand - Active power
C Pred phase C predicted
4074 Dmd - Active Power Ph kW 10 Demand - Active power
C Peak phase C peak
4084 Dmd - Reactive Power kVAR 10 Demand - Reactive

Ph C Last

power phase C last
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Object ID Object name Units Default Description
cov
4086 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph C Present power phase C present
4088 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph C Pred power phase C predicted
4090 Dmd - Reactive Power kVAR 10 Demand - Reactive
Ph C Peak power phase C peak
4100 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph C Last power phase C last
4102 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph C Present power phase C present
4104 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph C Pred power phase C predicted
4106 Dmd - Apparent Power kVA 10 Demand - Apparent
Ph C Peak power phase C peak
Current demand
Object ID Object name Units Default Description
cov
3812 Dmd - Active CurrentPh | A 10 Demand - Active current
A Last phase A last
3814 Dmd - Current Ph A A 10 Demand - Current phase
Present A present
3816 Dmd - Active CurrentPh | A 10 Demand - Active current
A Pred phase A predicted
3818 Dmd - Active CurrentPh | A 10 Demand - Active current
A Peak phase A peak
3828 Dmd - Active CurrentPh | A 10 Demand - Active current
B Last phase B last
3830 Dmd - Current Ph B A 10 Demand - Current phase
Present B present
3832 Dmd - Active CurrentPh | A 10 Demand - Active current
B Pred phase B predicted
3834 Dmd - Active CurrentPh | A 10 Demand - Active current
B Peak phase B peak
3844 Dmd - Active CurrentPh | A 10 Demand - Active current
C Last phase C last
3846 Dmd - Current Ph C A 10 Demand - Current phase
Present C present
3848 Dmd - Active CurrentPh | A 10 Demand - Active current
C Pred phase C predicted
3850 Dmd - Active CurrentPh | A 10 Demand - Active current
C Peak phase C peak
3860 Dmd - Current Neutral A 10 Demand - Current
Last neutral last
3862 Dmd - Current Neutral A 10 Demand - Current
Present neutral present
3864 Dmd - Current Neutral A 10 Demand - Current
Pred neutral predicted
3866 Dmd - Current Neutral A 10 Demand - Current
Peak neutral peak
3876 Dmd - Average Current A 10 Demand - Average
Last current last
3878 Dmd - Avg Current A 10 Demand - Average
Present current present
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Object ID Object name Units Default Description
cov
3880 Dmd - Average Current A 10 Demand - Average
Pred current predicted
3882 Dmd - Average Current A 10 Demand - Average
Peak current peak
Power quality
Object ID Object name Units Default Description
cov
21300 THD Current - Ph A % 20 THD Current A
21302 THD Current - Ph B % 20 THD Current B
21304 THD Current-Ph C % 20 THD Current C
21306 THD Current-Ph N % 20 THD Current N
21308 THD Current- Ph G % 20 THD Current G
21310 thd Current - Ph A % 20 thd Current A
21312 thd Current - Ph B % 20 thd Current B
21314 thd Current-Ph C % 20 thd Current C
21316 thd Current - Ph N % 20 thd Current N
21318 thd Current - Ph G % 20 thd Current G
21320 Total Dmd Distortion % 20 Total Demand Distortion
21322 THD Voltage - A-B % 20 THD Voltage A-B
21324 THD Voltage - B-C % 20 THD Voltage B-C
21326 THD Voltage - C-A % 20 THD Voltage C-A
21328 THD Voltage - Avg L-L % 20 THD Voltage L-L
21330 THD Voltage - A-N % 20 THD Voltage A-N
21332 THD Voltage - B-N % 20 THD Voltage B-N
21334 THD Voltage - C-N % 20 THD Voltage C-N
21338 THD Voltage - Avg L-N % 20 THD Voltage L-N
21340 thd Voltage - A-B % 20 thd Voltage A-B
21342 thd Voltage - B-C % 20 thd Voltage B-C
21344 thd Voltage - C-A % 20 thd Voltage C-A
21346 thd Voltage - Avg L-L % 20 thd Voltage L-L
21348 thd Voltage - A-N % 20 thd Voltage A-N
21350 thd Voltage - B-N % 20 thd Voltage B-N
21352 thd Voltage - C-N % 20 thd Voltage C-N
21356 thd Voltage - Avg L-N % 20 thd Voltage L-N

Meter information

The following table lists Analog Input objects that provide information about the

meter and its configuration.

NOTE: You can access the meter’s configuration information over BACnet
communications. However, you must use the display, meter webpages or ION

Setup to configure the meter’s settings.
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Object ID Object name Units Default Description
cov
2000 Time since last meter Seconds 604800 Time since the meter
power up was last powered up

2004 Meter operation timer Seconds 604800 Total meter operation
time

2014 Number of phases — 1 Number of phases
1,3

2015 Number of wires — 1 Number of wires
2,3,4

2017 Nominal frequency Hz 1 Nominal frequency
50, 60

2025 Number of VTs — 1 Number of VTs
0,2,3

2026 VT primary \% 1 VT Primary

2028 VT secondary \% 1 VT Secondary

2029 Number of CTs — 1 Number of CTs
1,2,3

2030 CT primary 1 CT Primary

2031 CT secondary 1 CT Secondary

Binary Input objects

Your meter has a number of Binary Input objects that provide the status
information from the meter’s 1/0.

The following table lists the Binary Input (BI) objects available on the meter.

Object ID

Object name

Description

38416, 38417

Digital Input 1
Digital Input 2

0=on
1 = off

NOTE: This information only applies if the
digital input is configured as a status input.

Status of digital inputs 1 and 2:

38448, 38449

Digital Output 1
Digital Output 2

0=on
1 = off

Status of digital outputs 1 and 2:

Multi-state Input objects

Your meter has a number of Multi-state Input objects that provide information
about the meter’s I/O and power system settings.
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Meter configuration multi-state input objects

Object ID

Object name

Object name / description

2016

Power System Type

Power system configuration:
0=1PH2W L-N

1=1PH2W L-L

2 =1PH3W L-L with N

3 = 3PH3W ungrounded delta

4 = 3PH3W corner grounded delta

5 = 3PH3W ungrounded wye

6 = 3PH3W grounded wye

7 = 3PH3W resistance grounded wye
8 = 3PH4W center-tapped open delta
9 = 3PH4W center-tapped delta

10 = 3PH4W ungrounded wye

11 = 3PH4W grounded wye

12 = 3PH4W resistance grounded
wye

2036

VT Connection Type

VT connection type:
0 = Direct connect
1= Delta (2 VT)

2 =Wye (3 VT)
3=L-N(1VT)
4=L-L(1VT)
5=L-LwithN (2 VT)

3701

Demand Method - Power

Power demand method:

0 = Thermal demand

1 = Timed interval sliding block

2 = Timed interval block

3 = Timed interval rolling block

4 = Input synchronized block

5 = Input synchronized rolling block
6 = Command synchronized block

7 = Command synchronized rolling
block

8 = Clock synchronized block

9 = Clock synchronized rolling block
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Object ID Object name

Object name / description

371 Demand Method - Current

Current demand method:

0 = Thermal demand

1 = Timed interval sliding block

2 = Timed interval block

3 = Timed interval rolling block

4 = Input synchronized block

5 = Input synchronized rolling block
6 = Command synchronized block

7 = Command synchronized rolling
block

8 = Clock synchronized block
9 = Clock synchronized rolling block

3721 Demand Method - Input
Metering

Input metering demand method:

0 = Thermal demand

1 = Timed interval sliding block

2 = Timed interval block

3 = Timed interval rolling block

4 = Input synchronized block

5 = Input synchronized rolling block
6 = Command synchronized block

7 = Command synchronized rolling
block

8 = Clock synchronized block
9 = Clock synchronized rolling block

/0 multi-state input objects

The following table lists the Multi-state Input objects that provide information about

meter’s 1/O configuration.

Object ID Object name

Description

7274, 7298 Digital Input 1 Mode
Digital Input 2 Mode

Digital Input 1 and 2 control mode
0 = Normal (Alarm)

1 = Demand Interval Sync Pulse
2 = Multi-tariff Control

9673, 9681 Digital Output Mode 1
Digital Output Mode 2

Digital output 1 and 2 control mode
0 = External

1 =Demand Sync

2 = Alarm

3 = Energy
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Logging
Data log

Setting up the data log

Saving the data log contents using ION Setup

The meter has an alarm log and data logging for selected values.

Logs are stored in the non-volatile memory of the meter and are referred to as on-
board logs. The data log is disabled from the factory.

You can select the items to record in the data log and the frequency (logging
interval) that you want those values updated

Use ION Setup to configure data logging.

NOTICE

DATA LOSS
Save the contents of the data log before configuring it.

Failure to follow these instructions can result in data loss.

1. Start ION Setup and open your meter in setup screens mode (View > Setup
Screens). See the ION Setup Help for instructions.

2. Double-click Data Log #1.
3. Set up the logging frequency and measurements/data to log.

4. Click Send to save the changes to the meter.

can vary based on the meter
type.

Parameter Values Description
Status Enable, Disable Set this parameter to enable
or disable data logging in the
meter.
Interval 15 minutes, 30 minutes, 60 Select a time value to set the
minutes logging frequency.
Channels Items available for logging Select an item to record from

the “Available” column, then
click the double-right arrow
button to move the item to
the “Selected” column.

To remove an item, select it
from the “Selected” column
then click the double-left
arrow button.

You can use ION Setup to save the contents of the data log.

1. Start ION Setup and open your meter in data screens mode (View > Data
Screens. See the ION Setup help for instructions.

2. Double-click Data Log #1 to retrieve the records.

3. Once the records have finished uploading, right-click anywhere in the viewer
and select Export CSV from the popup menu to export the entire log.

NOTE: To export only selected records in the log, click the first record you
want to export, hold down the SHIFT key and click the last record you
want to export, then select Export CSV from the popup menu.
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4. Navigate to the folder where you want to save the data log file, then click
Save.

Alarm log

The meter can log the occurrence of any alarm condition.

Each time an alarm occurs it is entered into the alarm log. The alarm log in meter
stores the pickup and dropout points of alarms along with the date and time
associated with these alarms.

Alarm log storage

The power and energy meter stores alarm log data in non-volatile memory.

The size of the alarm log is fixed at 40 records.

Memory allocation for log files

Each file in the meter has a maximum memory size.

Memory is not shared between the different logs, so reducing the number of
values recorded in one log does not allow more values to be stored in different log.

Log type Maximum records stored Storage (bytes)
Alarm Log 40 2,200
Data Log 5760 256k

Maintenance log

The meter records maintenance-type events such as changes to meter setup.

You can use a web browser to view the contents of the maintenance log.
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Available 1/O ports

The meter is equipped with status inputs, digital outputs and relay outputs.

ADANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

» Apply appropriate personal protective equipment (PPE) and follow safe
electrical work practices. See NFPA 70E in the USA, CSA Z462 or
applicable local standards.

» Turn off all power supplying this device and the equipment in which it is
installed before working on the device or equipment.

» Always use a properly rated voltage sensing device to confirm that all power
is off.

» Treat communications and I/O wiring connected to multiple devices as
hazardous live until determined otherwise.

» Do not exceed the device’s ratings for maximum limits.

* Do not use this device for critical control or protection applications where
human or equipment safety relies on the operation of the control circuit.

* Do not use the data from the meter to confirm power is off.

* Replace all devices, doors and covers before turning on power to this
equipment.

Failure to follow these instructions will result in death or serious injury.

After you wire the meter’s I/O ports, you can configure these ports so you can use
the meter to perform 1/O functions.

Models Status input ports? Digital output ports2 Relay output ports
PM5310 2 (S1+, S2+) 2 (D1+, D2+) —

PM5320 2 (S1+, S2+) 2 (D1+, D2+) —

PM5330 2 (S1+, S2+) 2 (D1+, D2+) 2 (Relay 1, Relay 2)
PM5331

PM5340

PM5341

1The meter’s status inputs require an external voltage source to detect the status input’s on/off
state. The meter detects an ON state if the external voltage appearing at the status input is within its
operating range. The external voltage can be derived from either the whetting output provided by
the meter or by a voltage source up to 36 V DC external to the meter.

2The digital outputs can handle voltages less than 40 V DC. For higher voltage applications, use an
external relay in the switching circuit.

Status input applications

Status inputs are typically used for monitoring the status of external contacts or
circuit breakers.

Status input wiring considerations

The meter’s status inputs require an external voltage source to detect the status
input’s on/off state.
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The meter detects an ON state if the external voltage appearing at the status input
is within its operating range. The external voltage can be derived from either the
whetting output provided by the meter or by a voltage source up to 36 V DC
external to the meter.

Configuring status inputs using the display

The status input ports (S1 and S2) can be configured using the display.

NOTE: It is recommended you use ION Setup to configure the status inputs,
as setup parameters that require text entry can only be modified using ION
Setup.

1. Navigate to Maint > Setup.
Enter the setup password (default is “0”), then press OK.

Navigate to /0 > S In.

A ow N

Move the cursor to point to the status input you want to set up, then press
Edit.

5. Move the cursor to point to the parameter you want to modify, then press
Edit.

NOTE: If Edit is not displayed, it means the parameter is either read-only
or can only be modified through software.

6. Modify the parameter as required, then press OK.

7. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

8. Press the up arrow to exit. Press Yes to save your changes.

Parameter Values Description

Label — This can be modified only
through software. Use this
field to assign names to the
status inputs (S1 and S2).

Debounce Time (ms) 0to 1000 Debounce is the time delay
that compensates for
mechanical contact bounce.
Use this field to set how long
(in milliseconds) the external
signal must remain in a
certain state to be
considered a valid state
change.

Control Mode Normal This field displays how the
status input functions.

Normal: the status input is
not associated with another
meter function. The meter
counts and records the
number of incoming pulses
normally.

Configuring status inputs using ION Setup

The status input ports (S1 and S2) can be configured using ION Setup.

1. Start ION Setup.
2. Connect to your meter.

3. Navigate to I/0 configuration > 1/O Setup.
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4. Select a status input to configure and click Edit.
The setup screen for that status input is displayed.
5. Enter a descriptive name for the status input’s Label.

6. Configure the other setup parameters as required.

7. Click Send to save your changes.

Status input setup parameters available through ION Setup

Demand Sync

Parameter Values Description

Label — Use this field to change the default label and assign a
descriptive name to this status input.

Control Mode Normal, This field displays how the status input functions.

Normal: the status input is not associated with
another meter function. The meter counts and
records the number of incoming pulses normally.

Demand Sync: the status input is associated with
one of the input sync demand functions. The
meter uses the incoming pulse to synchronize its
demand period with the external source.

Debounce 0to 9999 Debounce is the time delay that compensates for
mechanical contact bounce. Use this field to set how
long (in milliseconds) the external signal must remain in
a certain state to be considered a valid state change.

Associations — This field displays additional information if the status

input is already associated with another meter function.

Digital output applications

Digital outputs are typically used in switching applications, for example, to provide
on/off control signals for switching capacitor banks, generators, and other external
devices and equipment.

The digital output can also be used in demand synchronization applications,

where the meter provides pulse signals to the input of another meter to control its

demand period. The digital output can also be used in energy pulsing applications,

where a receiving device determines energy usage by counting the kWh pulses
coming from the meter’s digital output port.

The digital output ports on the meter are internally designed using solid-state
devices with an open-collector configuration. These ports must be connected to
the specified power supply with a current limiter to function. Refer to the digital

output application example below for more information.

Digital output application example

You can connect one of your meter’s digital outputs to a relay that switches on a

generator and the other digital output to send a demand sync pulse to other

meters.

In the following example, the first meter (Meter 1) controls and sets the demand
period (900 seconds) of the other meters (Meter 2, Meter 3, Meter 4) through the

output pulse occurring at the end of the first meter’s demand interval.
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A | Relay
Meter 1

*************

B | Demand period (in this example,

i WHB@ 3 900 seconds)

Power |4 S20mA Y E)
source

<40VDC |- T G =
— H 56504

Meter 2 Meter 3 Meter 4

Configuring digital outputs using the display

You can use the display to configure the digital outputs.

NOTE: It is recommended you use ION Setup to configure the digital outputs,
as setup parameters that require text entry can only be modified using
software.

1. Navigate to Maint > Setup.
Enter the setup password, then press OK.

Navigate to /0 > D Out.

oW N

Move the cursor to point to the digital output you want to set up, then press
Edit.

5. Edit the parameters as required.

a. Move the cursor to point to the parameter you want to modify, then press
Edit

b. Modify the parameter as required, then press OK.

c. Move the cursor to point to the next parameter you want to modify, press
Edit, make your changes, then press OK.

NOTE: If Edit is not displayed, it means the parameter is either read-only
or can only be modified through software.
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Digital output setup parameters available through the display

6. Press the up arrow to exit. Press Yes to save your changes.

Setting

Option or range

Description

Label

This can be modified only through software. Use this
field to change the default label and assign a
descriptive name to this digital output.

Control Mode

External, Demand Sync, Alarm, Energy

This field displays how the digital output functions.

« External: the digital output is controlled remotely
either through software or by a PLC using
commands sent through communications.

« Demand Sync: the digital output is associated
with one of the demand systems. The meter
sends a pulse to the digital output port at the
end of every demand interval.

« Alarm: the digital input is associated with the
alarm system. The meter sends a pulse to the
digital output port when the alarm is triggered.

« Energy: The digital output is associated with
energy pulsing. When this mode is selected,
you can select the energy parameter and the
set the pulse rate (pulses/kW).

Behavior Mode

Normal, Timed, Coil Hold

« Normal: this mode applies when control mode is
set to External or Alarm. In the event of trigger
for External mode, the digital output remains in
the ON state until an OFF command is sent by
the computer or PLC. In the event of trigger for
Alarm mode, the digital output remains in the
ON state until the drop out point is crossed.

« Timed: the digital output remains ON for the
period defined by the On Time setup register.

«  Coil Hold: this mode applies when control mode
is set to External or Alarm. For a unary alarm
that is associated with a digital output, you must
set Behavior Mode to Coil Hold. The output
turns on when the “energize” command is
received and turns off when the “coil hold
release” command is received. In the event of a
control power loss, the output remembers and
returns to the state it was in when control power
was lost.

On Time (s)

0 to 9999

This setting defines the pulse width (ON time) in
seconds.

NOTE: In energy mode, the digital output pulse
ON time is fixed for 20 ms.

Select Dmd System

Power, Current

Applies when Control Mode is set to Demand Sync.
Select the demand system to monitor.

Select Alarms

All available alarms

Applies when Control Mode is set to Alarm. Select
one or more alarms to monitor.

Configuring digital outputs using ION Setup

You can use ION Setup to configure the digital outputs (D1 and D2).

1. Start ION Setup.

Connect to your meter.

> w0 DN

Navigate to I/O configuration > I/O Setup.

Select a digital output to configure and click Edit.

The setup screen for that digital output is displayed.

5. Enter a descriptive name for the digital output in the Label field.

6. Configure the other setup parameters as required.
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7. Click Send to save your changes.

Digital output setup parameters available using ION Setup

Parameter Values Description

Label — Use this field to change the default label and assign a
descriptive name to this digital output.

Control Mode External, Demand, Alarm, Energy This field displays how the digital output functions.

« External: the digital output is controlled remotely
either through software or by a PLC using
commands sent through communications.

+ Demand: the digital output is associated with
one of the demand systems. The meter sends a
pulse to the digital output port at the end of
every demand interval.

+ Alarm: the digital input is associated with the
alarm system. The meter sends a pulse to the
digital output port when the alarm is triggered.

* Energy: The digital output is associated with
energy pulsing. When this mode is selected,
you can select the energy parameter and the
set the pulse rate (pulses/kW).

Behavior Mode Normal, Timed, Coil Hold *  Normal: this mode applies when control mode is
set to External or Alarm. In the event of trigger
for External mode, the digital output remains in
the ON state until an OFF command is sent by
the computer or PLC. In the event of trigger for
Alarm mode, the digital output remains in the
ON state until the drop out point is crossed.

»  Timed: the digital output remains ON for the
period defined by the On Time setup register.

*  Coil Hold: this mode applies when control mode
is set to External or Alarm. For a unary alarm
that is associated with a digital output, you must
set Behavior Mode to Coil Hold. The output
turns on when the “energize” command is
received and turns off when the “coil hold
release” command is received. In the event of a
control power loss, the output remembers and
returns to the state it was in when control power
was lost.

On Time (s) 0 to 9999 This setting defines the pulse width (ON time) in
seconds.

NOTE: In energy mode, the digital output pulse
ON time is fixed for 20 ms.

Select Dmd System Power, Current Applies when Control Mode is set to Demand Sync.
Select the demand system to monitor.

Select Alarms All available alarms Applies when Control Mode is set to Alarm. Select
one or more alarms to monitor.

Associations — This field displays additional information if the digital
output is already associated with another meter
function.

Relay output applications

Relay outputs can be configured to be used in switching applications, for example,
to provide on/off control signals for switching capacitor banks, generators, and
other external devices and equipment.

Configuring relay outputs using ION Setup

You can use ION Setup to configure the relay output ports (Relay 1 and Relay 2).

1. Start ION Setup.

2. Connect to your meter.
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3. Navigate to I/0 configuration > I/O Setup.

4. Select a relay output to configure

The setup screen for that relay ou

and click Edit.
tput is displayed.

5. Enter a descriptive name for the relay output’s Label.

6. Configure the other setup parameters as required.

7. Click Send to save your changes.

Relay output setup parameters available through the ION Setup

Parameter

Values

Description

Label

Use this field to change the default label and assign a
descriptive name to this relay output.

Control Mode

External, Alarm

This field displays how the relay output functions.

« External: the relay output is controlled remotely
either through software or by a PLC using
commands sent through communications.

» Alarm: the relay output is associated with the
alarm system. The meter sends a pulse to the
relay output port when the alarm is triggered.

Behavior Mode

Normal, Timed, Coil Hold

»  Normal: this mode applies when control mode is
set to External or Alarm. In the event of trigger
for External mode, the relay output remains in
the closed state until an open command is sent
by the computer or PLC. In the event of trigger
for Alarm mode, the relay output remains in the
closed state until the drop out point is crossed.

» Timed: the relay output remains ON for the
period defined by the On Time setup register.

*  Coil Hold: this mode applies when control mode
is set to External or Alarm. For a unary alarm
that is associated with a relay output, you must
set Behavior Mode to Coil Hold. The output
turns on when the “energize” command is
received and turns off when the “coil hold
release” command is received. In the event of a
control power loss, the output remembers and
returns to the state it was in when control power
was lost.

On Time (s)

0 to 9999

This setting defines the pulse width (ON time) in
seconds.

Select Alarms

All available alarms

Applies when Control Mode is set to Alarm. Select
one or more alarms to monitor.

Associations

This field displays additional information if the relay
output is already associated with another meter
function.

Configuring relay outputs using the display

You can use the front panel to configure the relay outputs.

NOTE: It is recommended you use ION Setup to configure the relay outputs,
as setup parameters that require text entry can only be modified using

software.

—_

Navigate to Maint > Setup.

Navigate to I/O > Relay.

A w0 N

Move the cursor to point to the rel
Edit.

Enter the setup password (default is “0”), then press OK.

ay output you want to set up, then press
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5. Move the cursor to point to the parameter you want to modify, then press
Edit.

NOTE: If Edit is not displayed, it means the parameter is either read-only
or can only be modified through software.

6. Modify the parameter as required, then press OK.

7. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

8. Press the up arrow to exit, then press Yes to save your changes.

Relay output setup parameters available through the display

Parameter Values Description

Label — Use this field to change the default label and assign a
descriptive name to this relay output.

Control Mode External, Alarm This field displays how the relay output functions.

« External: the relay output is controlled remotely
either through software or by a PLC using
commands sent through communications.

« Alarm: the relay output is associated with the
alarm system. The meter sends a pulse to the
relay output port when the alarm is triggered.

Behavior Mode Normal, Timed, Coil Hold * Normal: this mode applies when control mode is

set to External or Alarm. In the event of trigger
for External mode, the relay output remains in
the closed state until an open command is sent
by the computer or PLC. In the event of trigger
for Alarm mode, the relay output remains in the
closed state until the drop out point is crossed.

+ Timed: the relay output remains ON for the
period defined by the On Time setup register.

*  Coil Hold: this mode applies when control mode
is set to External or Alarm. For a unary alarm
that is associated with a relay output, you must
set Behavior Mode to Coil Hold. The output
turns on when the “energize” command is
received and turns off when the “coil hold
release” command is received. In the event of a
control power loss, the output remembers and
returns to the state it was in when control power
was lost.

On Time (s) 0 to 65535 This setting defines the pulse width (ON time) in
seconds.

Select Alarms All available alarms Applies when Control Mode is set to Alarm. Select
one or more alarms to monitor.

Energy pulsing

You can configure the meter’s alarm /energy LED or one of the digital outputs for
energy pulsing.

* The meter is equipped with an alarm / energy pulsing LED. When configured
for energy pulsing, the LED emits pulses that are then used to determine the
accuracy of the meter’s energy measurements.

» The meter is equipped with digital outputs. When you configure a digital
output for energy pulsing, the meter sends voltage pulses to the digital output
port, which are then used to determine the accuracy of the meter’s energy
measurements.

Configuring the alarm / energy pulsing LED using the display

You can use the display to configure your meter’s LED for alarming or energy
pulsing applications.
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Navigate to Maint > Setup.

Enter the setup password (default is “0”), then press OK.

Navigate to 110 > LED.

Move the cursor to point to the parameter you want to modify, then press

Edit.

Press the plus or minus buttons to modify the parameter as required, then

press OK.

Press the up arrow to exit. Press Yes to save your changes.

Active Del + Rec
Reactive Del
Reactive Rec
Reactive Del + Rec
Apparent Del
Apparent Rec
Apparent Del + Rec

Setting Option or range Description
Mode Off, Alarm, Energy Off turns off the LED completely.
Alarm sets the LED for alarm
notification.
Energy sets the LED for energy pulsing.
Parameter Active Del Select which ac_cumulated energy
channel to monitor and use for energy
Active Rec pulsing. This setting is ignored when the

LED mode is set to Alarm.

Pulse Wt. (p/k_h)

1 to 9999999

When configured for energy pulsing, this
setting defines how many pulses are
sent to the LED for every 1 kWh, 1
kVARh or 1kVAh accumulated energy.
This setting is ignored when the LED
mode is set to Alarm.

Configuring the alarm / energy pulsing LED or digital output for energy pulsing using

ION Setup
You can use ION Setup to configure your meter’s LED or digital output for energy
pulsing.
1. Start ION Setup.
2. Connect to your meter.
3. Navigate to I/0 configuration > Energy Pulsing.
4. Select the LED or a digital output to configure and click Edit.
The setup screen is displayed.
5. Enter a descriptive name for the digital output’s Label.
6. Configure the other setup parameters as required.
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7. Click Send to save your changes.

Alarm / energy pulsing LED setup parameters available through ION

Setup
Parameter Values Description
Mode Off, Alarm, Energy Off disables the LED.

Alarm sets the LED for alarm
notification.

Energy sets the LED for energy
pulsing.

Pulse Wt. (p/k_h)

1 to 9999999

When configured for energy
pulsing, this defines how many
pulses are sent to the LED for every
1 kWh, 1 kVARh or 1 kVAh of
accumulated energy.

Channel

Active Energy Delivered,
Active Energy Received,
Active Energy Del+Rec,
Reactive Energy Delivered,
Reactive Energy Received,
Reactive Energy Del+Rec,
Apparent Energy Delivered,
Apparent Energy Received,
Apparent Energy Del+Rec

Select which accumulated energy
channel to monitor and use for
energy pulsing.
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Alarms overview

An alarm is the meter’s means of notifying you when an alarm condition is
detected, such as an error or an event that falls outside of normal operating
conditions.

Alarms are typically setpoint-driven and can be programmed to monitor certain
behaviors, events or unwanted conditions in your electrical system.

You can configure your meter to generate and display high, medium and low
priority alarms when predefined events are detected in the meter’'s measured
values or operating states. Your meter also logs the alarm event information.

The meter ships with some alarms already enabled from the factory. Other alarms
need to be configured before the meter can generate alarms.

Your can customize the meter alarms as required, such as changing the priority.
You can also create custom alarms using the advanced features of your meter.

Available alarms

Your meters supports a number of different alarm types.

Type Number
Unary 4

Digital 4
Standard 29

Unary alarms

A unary alarm is the simplest type of alarm — it monitors a single behavior, event
or condition.

Available unary alarms

Your meter has a set of 4 unary alarms.

Alarm label Description

Meter Powerup Meter powers on after losing control power.

Meter Reset Meter resets for any reason.

Meter Diagnostic Meter’s self-diagnostic feature detects a problem.
Phase Reversal Meter detects a phase rotation different than expected.

Digital alarms

Digital alarms monitor the ON or OFF state of the meter’s digital / status inputs.

Digital alarm with setpoint delay

To prevent false triggers from erratic signals, you can set up pickup and dropout
time delays for the digital alarm.
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Available digital alarms

Standard alarms

< AT1 > \/\/ «— AT2 —»

0 f—t-Af - B
< AT3
EV1 EV2

A Pickup setpoint (1 = ON) AT2 Dropout time delay (in seconds)
B Dropout setpoint (0 = OFF) EV2 End of alarm condition
AT1 Pickup time delay (in seconds) AT3 Alarm duration (in seconds)
EV1 Start of alarm condition

NOTE: To prevent filling the alarm log with nuisance alarm trips, the digital
alarm is automatically disabled if the digital / status input changes state more
than 4 times in one second or more than 10 times in ten seconds. In this case,
you must re-enable the alarm using the display or ION Setup.

Your meter has 2 digital alarms.

Alarm label Description
Digital Alarm S1 Status input 1
Digital Alarm S2 Status input 2

Standard alarms are setpoint-driven alarms which monitor certain behaviors,
events or unwanted conditions in your electrical system.

Standard alarms have a detection rate equal to the 50/60 meter cycle, which is
nominally 1 second if the meter’s frequency setting is configured to match the
system frequency (50 or 60 Hz).

Many of the standard alarms are three-phase alarms. Alarm setpoints are
evaluated for each of the three phases individually, but the alarm is reported as a
single alarm. The alarm pickup occurs when the first phase exceeds the alarm
pickup magnitude for the pickup time delay. The alarm is active as long as any
phase remains in an alarm state. The alarm dropout occurs when the last phase
drops below the dropout magnitude for the dropout time delay.

Example of over and under setpoint (standard) alarm operation

The meter supports over and under setpoint conditions on standard alarms.

A setpoint condition occurs when the magnitude of the signal being monitored
crosses the limit specified by the pickup setpoint setting and stays within that limit
for a minimum time period specified by the pickup time delay setting.

The setpoint condition ends when the magnitude of the signal being monitored
crosses the limit specified by dropout setpoint setting and stays within that limit for
a minimum time period specified by dropout time delay setting.

Over setpoint

When the value rises above the pickup setpoint setting and remains there long
enough to satisfy the pickup time delay period (AT1), the alarm condition is set to
ON. When the value falls below the dropout setpoint setting and remains there
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long enough to satisfy the dropout time delay period (AT2), the alarm condition is
set to OFF.

Max2

A Pickup setpoint
B Dropout setpoint
AT1 Pickup time delay period (in seconds)
EV1 Start of alarm condition
AT2 Dropout time delay (in seconds)
EV2 End of alarm condition
AT3 Alarm duration (in seconds)
EV2
Max1 Maximum value recorded during pickup period
Max2 Maximum value recorded during alarm period

The meter records the date and time when the alarm event starts (EV1) and when
it ends (EV2). The meter also performs any task assigned to the event, such as
operating a digital output. The meter also records maximum values (Max1, Max2)
before, during or after the alarm period.

Under setpoint

When the value falls below the pickup setpoint setting and remains there long
enough to satisfy the pickup time delay period (AT1), the alarm condition is set to
ON. When the value rises above the dropout setpoint setting and remains there

long enough to satisfy the dropout time delay period (AT2), the alarm condition is
set to OFF.

Min2

EV1

A Pickup setpoint
B Dropout setpoint
AT1 Pickup time delay period (in seconds)
EV1 Start of alarm condition
AT2 Dropout time delay (in seconds)
EV2 End of alarm condition
i AT3 Alarm duration (in seconds)
Min1 Minimum value recorded during pickup period
Min2 Minimum value recorded during alarm period

The meter records the date and time when the alarm event starts (EV1) and when
it ends (EV2). The meter also performs any task assigned to the event, such as
operating a digital output. The meter also records minimum values (Min1, Min2)
before, during or after the alarm period.

Maximum allowable setpoint

The meter is programmed to help prevent user data entry errors, with set limits for
the standard alarms.

The maximum setpoint value you can enter for some of the standard alarms
depends on the voltage transformer ratio (VT ratio), current transformer ratio (CT
ratio), system type (i.e., number of phases) and/or the maximum voltage and
maximum current limits programmed at the factory.

NOTE: VT ratio is the VT primary divided by the VT secondary and CT ratio is
the CT primary divided by the CT secondary.
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Standard alarm

Maximum setpoint value

Over Phase Current

(maximum current) x (CT ratio)

Under Phase Current

(maximum current) x (CT ratio)

Over Neutral Current

(maximum current) x (CT ratio) x (number of phases)

Over Ground Current

(maximum current) x (CT ratio)

Over Voltage L-L

(maximum voltage) x (VT ratio)

Under Voltage L-L

(maximum voltage) x (VT ratio)

Over Voltage L-N

(maximum voltage) x (VT ratio)

Under Voltage L-N

(maximum voltage) x (VT ratio)

Over Active Power

(maximum voltage) x (maximum current) x (number of phases)

Over Reactive Power

(maximum voltage) x (maximum current) x (number of phases)

Over Apparent Power

(maximum voltage) x (maximum current) x (number of phases)

Over Present Active Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Last Active Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Predicted Active Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Present Reactive Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Last Reactive Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Predicted Reactive Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Present Apparent Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Last Apparent Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Predicted Apparent Power Demand

(maximum voltage) x (maximum current) x (number of phases)

Over Voltage Unbalance

(maximum voltage) x (VT ratio)

Phase Loss

(maximum voltage) x (VT ratio)

Available standard alarms

Your meter has a set of standard alarms.

NOTE: Some alarms do not apply to all power system configurations. For
example, line-to-neutral voltage alarms cannot be enabled on 3-phase delta

systems. Some alarms use the system type and the VT or CT ratio to
determine the maximum allowed setpoint.

Alarm label Valid range and resolution

Units
ION Setup Display ION Setup Display
Over Phase Current Over Current, Ph 0.000 to 99999.000 0 to 99999 A
Under Phase Current Under Current, Ph 0.000 to 99999.000 0 to 99999 A
Over Neutral Current Over Current, N 0.000 to 99999.000 0 to 99999 A
Over Ground Current Over Current, Gnd 0.000 to 99999.000 0 to 99999 A
Over Voltage L-L Over Voltage, L-L 0.00 to 999999.00 0 to 999999 \Y
Under Voltage L-L Under Voltage, L-L 0.00 t0 999999.00 0 to 999999 \%
Over Voltage L-N Over Voltage, L-N 0.00 to 999999.00 0 to 999999 \Y
Under Voltage L-N Under Voltage L-N 0.00 t0 999999.00 0 to 999999 Vv
Over Active Power Over kW 0.0 t0 9999999.0 0 to 9999999 kw
Over Reactive Power Over kVAR 0.0 t0 9999999.0 0 to 9999999 kVAR
Over Apparent Power Over kVA 0.0 t0 9999999.0 0 to 9999999 kVA
Leading True PF Lead PF, True -1.00 to -0.01 and 0.01 to 1.00 —
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Alarm label Valid range and resolution
Units
ION Setup Display ION Setup Display
Lagging True PF Lag PF, True -1.00 to -0.01 and 0.01 to 1.00 —
Leading Disp PF Lead PF, Disp -1.00 to -0.01 and 0.01 to 1.00 —
Lagging Disp PF Lag PF, Disp -1.00 to -0.01 and 0.01 to 1.00 —
Over Present Active Power Over kW Dmd, Pres 0.0 t0 9999999.0 0 to 9999999 kW
Demand
Over Last Active Power Over kW Dmd, Last 0.0 t0 9999999.0 0 to 9999999 kW
Demand
Over Predicted Active Power | Over kW Dmd, Pred 0.0 t0 9999999.0 0 to 9999999 kW
Demand
Over Present Reactive Over kVAR Dmd, Pres 0.0 t0 9999999.0 0 to 9999999 kVAR
Power Demand
Over Last Reactive Power Over kVAR Dmd, Last 0.0 t0 9999999.0 0 to 9999999 kVAR
Demand
Over Predicted Reactive Over kVAR Dmd, Pred 0.0 t0 9999999.0 0 to 9999999 kVAR
Power Demand
Over Present Apparent Over kVA Dmd, Pres 0.0 t0 9999999.0 0 to 9999999 kVA
Power Demand
Over Last Apparent Power Over kVA Dmd, Last 0.0 t0 9999999.0 0 to 9999999 kVA
Demand
Over Predicted Apparent Over kVA Dmd, Pred 0.0 t0 9999999.0 0 to 9999999 kVA
Power Demand
Over Frequency Over Frequency 0.000 to 99.000 Hz
Under Frequency Under Frequency 0.000 to 99.000 Hz
Over Voltage Unbalance Over Voltage Unbal 0to 99 %
Over Voltage THD Over Voltage THD 0to 99 %
Phase Loss Phase Loss 0.00 too 999999.00 0 to 999999 —

Power factor (PF) alarms

You can set up a Leading PF or Lagging PF alarm to monitor when the circuit’s

power factor goes above or below the threshold you specify.

The Leading PF and Lagging PF alarms use the power factor quadrants as the
values on the y-axis, with quadrant |l on the lowest end of the scale, followed by
quadrant Ill, quadrant |, and finally quadrant IV on the highest end of the scale.

Quadrant PF values Lead/Lag

Il 0to-1 Leading (capacitive)
1l -1t00 Lagging (inductive)

| Oto1 Lagging (inductive)
v 1t00 Leading (capacitive)

Leading PF alarm

The Leading PF alarm monitors an over setpoint condition.
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«— AT2 —»!

Lagging PF alarm

EV1 EV2
A Pickup setpoint AT2 Dropout time delay (in seconds)
B Dropout setpoint EV2 End of alarm condition
AT1 Pickup delay period (in seconds) AT3 Alarm duration (in seconds)
EV1 Start of alarm condition

The Lagging PF alarm monitors an under setpoint condition.

Phase loss alarm

A Pickup setpoint AT2 Dropout time delay (in seconds)
B Dropout setpoint EV2 End of alarm condition

AT1 Pickup delay period (in seconds) AT3 Alarm duration (in seconds)
EV1 Start of alarm condition

The phase loss alarm is an under setpoint alarm that monitors the voltages on a 3-
phase system and triggers the alarm when one or two phases fall below the

pickup setpoint setting and remain there long enough to satisfy the pickup time

delay period.

When all of the phases rise above the dropout setpoint setting and remain there

long enough to satisfy the dropout time delay period, the alarm condition is set to

OFF.

Alarm priorities

Each alarm has a priority level that you can use to distinguish between events that
require immediate action and those that do not require action.

Alarm priority

Alarm display notification and recording method

Alarm LED

Alarm icon

Alarm details

Alarm logging

High

Blinks while the alarm is
active.

Blinks while the alarm is
active. Alarm icon remains
displayed until
acknowledged.

Click Details to display
what caused the alarm to
pickup or drop off. Click
Ack to acknowledge the
alarm.

Recorded in alarm log.

Medium

Blinks while the alarm is
active.

Blinks while the alarm is
active.

Click Details to display
what caused the alarm to
pickup or drop off.

Recorded in alarm log.
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Alarm priority Alarm display notification and recording method
Alarm LED Alarm icon Alarm details Alarm logging
Low Blinks while the alarm is Blinks while the alarm is Click Details to display Recorded in alarm log.
active. active. what caused the alarm to
pickup or drop off.
None No activity None None Recorded in event log only.

NOTE: The alarm LED notification only occurs if the alarm / energy pulsing
LED is configured for alarming.

Multiple alarm considerations

If multiple alarms with different priorities are active at the same time, the display
shows the alarms in the order they occurred.

Alarm setup overview

You can use the meter display or ION Setup to configure unary, digital or standard
(1-Sec) alarms.

If you make changes to the basic power meter setup, all alarms are disabled to
prevent undesired alarm operation. If you configure standard alarm setpoints
using the display, any decimals previously configured using ION Setup are lost.

UNINTENDED EQUIPMENT OPERATION
+ Verify all alarm settings are correct and make adjustments as necessary.

* Re-enable all configured alarms.

Failure to follow these instructions can result in incorrect alarm functions.

Built-in error-checking

ION Setup dynamically checks incorrect setup combinations. When you enable an
alarm, you must set up the pickup and dropout limits to acceptable values first in
order to exit the setup screen.

Setting up alarms using the display

You can use the display to create and set up standard (1-Sec), unary and digital
alarms.

It is recommended that you use ION Setup to configure standard (1-Sec) alarms.
ION Setup supports a higher resolution to allow you to specify more decimal
places when setting up the pickup setpoint and dropout setpoint values for certain
measurements.

1. Navigate to the alarms setup menu screens and select the alarm you want to
set up.

2. Configure the setup parameters as explained in the different alarm setup
sections.

NOTE: If you used ION Setup to program decimal values on a standard
(1-Sec) alarm, do not use the meter display to make subsequent changes
to any alarm parameters (including enable/disable), as doing so will
cause removal of all decimals previously programmed through ION
Setup.

3. Click Yes to save the changes to the meter when prompted.
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Setting up alarms using ION Setup

You can use ION Setup to create and set up alarms.

AN

Open the Alarming screen.

. Start ION Setup and connect to your meter.

Select the alarm you want to configure and click Edit.

Configure the setup parameters as explained in the different alarm setup

sections.

See the ION Setup Device Configuration guide for more information.

Unary alarm setup parameters

Configure the unary alarm setup parameters as required.

ION Setup controls are shown in parentheses.

Setting Option or range Description
Enable Yes (checked) or No (cleared) This enables or disables the alarm.
Priority High, Medium, Low, None This sets the alarm priority and notification

options.

Select Dig Output (Outputs)

Select Relay (Outputs)

None

Digital Output D1
Digital Output D2
Digital Output D1+D2
Relay R1

Relay R2

Relay R1+R2

Select the output(s) you want to control
when the alarm is triggered.

Digital alarm setup parameters

Configure the digital alarm setup parameters as required.

ION Setup controls are shown in parentheses.

Setting Option or range Description
Enable Yes (checked) or No (cleared) This enables or disables the alarm.
Priority High, Medium, Low, None This sets the alarm priority and notification

options.

Pickup Setpoint (Setpoint Pickup) On, Off Use this setting to control when to trip the
alarm, based on the state of the digital input
(On or Off).

Pickup Time Delay (Setpoint Pickup Delay) 0 to 999999 This specifies the number of seconds the

digital input must be in the alarm pickup
state before the alarm is tripped.
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Setting Option or range Description
Dropout Time Delay (Setpoint Dropout 0 to 999999 This specifies the number of seconds the

Delay)

digital input must be out of the alarm pickup
state before the alarm turns off.

Select Dig Output (Outputs)

Select Relay (Outputs)

None Select the output(s) you want to control
when the alarm is triggered.

Digital Output D1
Digital Output D2
Digital Output D1+D2
Relay R1

Relay R2

Relay R1+R2

Standard (1-Sec) alarm setup parameters

Configure the standard alarm setup parameters as required.

ION Setup controls are shown in parentheses.

NOTE: It is recommended that you use ION Setup to configure standard (1-
Sec) alarms. ION Setup supports a higher resolution to allow you to specify
more decimal places when setting up the pickup setpoint and dropout setpoint
values for certain measurements.

Setting Option or range Description

Enable Yes (checked) or No (cleared) This enables or disables the alarm.

Priority High, Medium, Low, None This sets the alarm priority and notification
options.

Pickup Setpoint (Pickup Limit)

Varies depending on the standard alarm you | This is the value (magnitude) you define as
are setting up the setpoint limit for triggering the alarm. For
“over” conditions, this means the value has
gone above the Pickup limit. For “under”
conditions, this means the value has gone
below the Pickup limit.

Pickup Time Delay (Delay)

0 t0 999999 This specifies the number of seconds the
signal must stay above the pickup setpoint
(for “over” conditions), or below the pickup
setpoint (for “under” conditions) before the
alarm is tripped.

Dropout Setpoint (Dropout Limit)

Varies depending on the standard alarm you | This is the value (magnitude) you define as
are setting up the limit for dropping out of the alarm
condition. For “over” conditions, this means
the value has gone below the Dropout limit.
For “under” conditions, this means the value
has gone above the Pickup limit.

Dropout Time Delay (Delay)

0 t0 999999 This specifies the number of seconds the
signal must stay below the dropout setpoint
(for “over” conditions), or above the dropout
setpoint (for “under” conditions) before the
alarm condition is ended.

PU Set Point Lead/Lag (Lead, Lag)

Lead or Lag Applies to PF (power factor) alarms only.
Use this to set the PF value and quadrant to
set the pickup setpoint for an over PF
condition (PF Leading) or under PF
condition (PF Lagging).

70

EAV15107-ENO5



Alarms PowerLogic™ PM5300 series

Setting Option or range Description

DO Set Point Lead/Lag (Lead, Lag) Lead or Lag Applies to PF (power factor) alarms only.
Use this to set the PF value and quadrant to
set the dropout setpoint for an over PF
condition (PF Leading) or under PF
condition (PF Lagging).

Select Dig Output (Outputs) None Select the output(s) you want to control
when the alarm is triggered.

Select Relay (Outputs) Digital Output D1
Digital Output D2
Digital Output D1+D2
Relay R1

Relay R2

Relay R1+R2

LED alarm indicator

You can use the meter’s alarm / energy pulsing LED as an alarm indicator.

When set to detect alarms, the LED blinks to indicate an alarm condition.

Configuring the LED for alarms using the display

You can use the meter display to configure the alarm / energy pulsing LED for
alarming.

1. Navigate to the LED setup menu screen.
2. Setthe mode to Alarm, then press OK.

3. Press the up arrow to exit. Press Yes to save your changes.

Configuring the LED for alarms using ION Setup

You can use the ION Setup to configure your meter’s LED for alarming.

1. Open ION Setup and connect to your meter. See the ION Setup Help for
instructions.

Navigate to I/O configuration > Energy Pulsing.
Select Front Panel LED and click Edit.

Set the control mode to Alarm.

o > 0N

Click Send to save your changes.

Alarm display and notification

The meter notifies you when an alarm condition is detected.

Alarm icon

When a low, medium or high priority alarm is tripped, this symbol appears at the
top right corner of the display screen, indicating that an alarm is active:
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For high priority alarms, the alarm icon remains displayed until you acknowledge
the alarm.

Alarm / energy pulsing LED

If configured for alarming, the alarm / energy pulsing LED also flashes to indicate
the meter has detected an alarm condition.

Alarm screens

You can use the display buttons to navigate to the alarm setup or display screens.

Active alarms

When a pickup event occurs, the active alarm list appears on the meter display’s
Active Alarms screen. Press Detail to see more event information.

Alarm details

Details about the alarms can be viewed using:

» the active alarms (Active), alarm history (Hist), alarm counters (Count) and
unacknowledged alarms (Unack) screens on the meter display, or

+ the Active Alarms and Alarm History screens on the meter webpages.

Active alarms list and alarm history log

Each occurrence of a low, medium or high priority alarm is stored in the active
alarms list and recorded in the alarm history log.

The active alarm list holds 40 entries at a time. The list works as a circular buffer,
replacing old entries as new entries over 40 are entered into the active alarms list.
The information in the active alarms list is volatile and reinitializes when the meter
resets.

The alarm history log holds 40 entries. The log also works as a circular buffer,
replacing old entries with new entries. The information in the alarm history log is
nonvolatile and is retained when the meter resets.

Viewing active alarm details using the display

When an alarm condition becomes true (alarm = ON), the alarm is displayed on
the active alarms screen.

Alarms are displayed sequentially in the order of their occurrence, regardless of
priority. The alarm details show the date and time of the alarm event, the type of
event (for example, pickup or unary), which phase the alarm condition was
detected on, and the value that caused the alarm condition.

NOTE: Alarm details are not available if the alarm priority is set to None.

The alarm details (for low, medium and high priority alarms) are also recorded in
the alarm history log.

1. Navigate to Alarm > Active.

2. Select the alarm you want to view (the latest ones appear on top).
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3. Press Detail.

NOTE: For unacknowledged high priority alarms, the Ack option appears
on this screen. Press Ack to acknowledge the alarm, or return to the
previous screen if you do not want to acknowledge the alarm.

Viewing alarm history details using the display

The alarm history log keeps a record of active alarms and past alarms.

When an active alarm condition becomes false (alarm = OFF), the event is
recorded in the alarm history log and alarm notification (alarm icon, alarm LED) is
turned off.

Alarms are displayed sequentially in the order of their occurrence, regardless of
priority. The alarm details show the date and time of the alarm event, the type of
event (for example, dropout or unary), which phase the alarm condition was
detected on, and the value that caused the alarm condition to turn ON or OFF.

NOTE: Alarm details are not available if the alarm priority is set to None.

1. Navigate to Alarm > Hist.
2. Select the alarm you want to view (the latest ones appear on top).

3. Press Detail.

NOTE: For unacknowledged high priority alarms, the Ack option appears
on this screen. Press Ack to acknowledge the alarm, or return to the
previous screen if you do not want to acknowledge the alarm.

Viewing alarms counters using the display

Every occurrence of each type of alarm is counted and recorded in the meter.
NOTE: The alarm counters roll over to zero after reaching the value 9999.

1. Select Alarm > Count.
The Alarms Counter screen displays.

2. Scroll through the list to view the number of alarm occurrences for each type
of alarm.
Acknowledging high-priority alarms using the display

You can use the meter display to acknowledge high-priority alarms.

1. Navigate to Alarm > Unack.
Select the alarm you want to acknowledge.
Press Detail.

Press Ack to acknowledge the alarm.

o > 0N

Repeat for other unacknowledged alarms.

Resetting alarms using ION Setup

Use ION Setup to reset alarms.

You can also reset alarms using the meter display.

1. Connect to your meter in ION Setup.

2. Open the Meter Resets screen.
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3. Select the alarm parameters to clear and click Reset.
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Measurements

Real-time readings

Energy

Min/max values

Demand

Power demand

Current demand

The power and energy meter measures current and voltages and reports in real
time the RMS (Root Mean Squared) values for all three phases and neutral.

The voltage and current inputs are continuously monitored at a sampling rate of
64 points per cycle. This amount of resolution helps enable the meter to provide
reliable measurements and calculated electrical values for various commercial,
buildings and industrial applications.

The meter calculates and stores accumulated energy values for real, reactive, and
apparent energy.

You can view accumulated energy from the display. The energy value units
automatically change, based on the quantity of energy accumulated (e.g., from
kWh to MWh, from MWh to GWh, then from GWh to TWh, from TWh to PWh).

When the readings reach their lowest or highest value, the meter updates and
saves these min/max (minimum and maximum) quantities in non-volatile memory.

The meter’s real-time readings are updated once every 50 cycles for 50 Hz
systems, or once every 60 cycles for 60 Hz systems.

Power demand is a measure of average power consumption over a fixed time
interval.

NOTE: If not specified, references to demand are assumed to mean power
demand.

The meter measures instantaneous consumption and can calculate demand using
various methods.

The meter calculates current demand using the block interval, synchronized or
thermal demand methods.

You can set the demand interval from 1 to 60 minutes in 1 minute increments (for
example, 15 minutes).

Power demand calculation methods

Power demand is calculated by dividing the energy accumulated during a
specified period by the length of that period.

How the meter performs this calculation depends on the method and time
parameters you select (for example, timed rolling block demand with a 15-minute
interval and 5-minute subinterval).
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To be compatible with electric utility billing practices, the meter provides the
following types of power demand calculations:

* Block interval demand
* Synchronized demand
* Thermal demand

You can configure the power demand calculation method from the display or
software.

Block interval demand

For block interval demand method types, you specify a period of time interval (or
block) that the meter uses for the demand calculation.

Select/configure how the meter handles that interval from one of these different
methods:

Type Description

Timed Sliding Block Select an interval from 1 to 60 minutes (in 1-minute increments). If
the interval is between 1 and 15 minutes, the demand calculation
updates every 15 seconds. If the interval is between 16 and 60
minutes, the demand calculation updates every 60 seconds. The
meter displays the demand value for the last completed interval.

Timed Block Select an interval from 1 to 60 minutes (in 1-minute increments). The
meter calculates and updates the demand at the end of each
interval.

Timed Rolling Block Select an interval and a subinterval. The subinterval must divide

evenly into the interval (for example, three 5-minute subintervals for
a 15-minute interval). Demand is updated at the end of each
subinterval. The meter displays the demand value for the last
completed interval.

Block interval demand example

The following illustration shows the different ways power demand is calculated
using the block interval method. In this example, the interval is set to 15 minutes.

Timed Sliding Block

. Demand value is
Calculation updates ~— e average for the

every 15 seconds . ) last completed interval
15-minute interval

Time (sec)
15304560 ...

Timed Block
~¢— Demand value is
Calculation updates at fgstiﬁa?;g the
the end of the interval . P
interval
15-minute interval 15-minute interval 15-min

Time
15 30 45 i)
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Timed Rolling Block

Calculation updates at the end ~¢—Demand value is

of the subinterval (5 minutes) the average for
the last completed
interval

15-minute interval

Time
15 20 25 30 35 40 45 (min)

Synchronized demand
You can configure the demand calculations to be synchronized using an external

pulse input, a command sent over communications, or the device’s internal real-
time clock.

Type Description
Input synchronized This method allows you to synchronize the demand interval of your meter
demand with an external digital pulse source (such as another meter’s digital

output) connected to your meter's digital input. This helps synchronize
your meter to the same time interval as the other meter for each demand
calculation.

Command This method allows you to synchronize the demand intervals of multiple
synchronized demand | meters on a communications network. For example, if a programmable
logic controller (PLC) input is monitoring a pulse at the end of a demand
interval on a utility revenue meter, you can program the PLC to issue a
command to multiple meters whenever the utility meter starts a new
demand interval. Each time the command is issued, the demand readings
of each meter are calculated for the same interval.

Clock synchronized This method allows you to synchronize the demand interval to the meter’s
demand internal real-time clock. This helps you synchronize the demand to a
particular time, typically on the hour (for example, at 12:00 am). If you
select another time of day when the demand intervals are to be
synchronized, the time must be specified in minutes from midnight. For
example, to synchronize at 8:00 am, select 480 minutes.

NOTE: For these demand types, you can choose block or rolling block
options. If you select a rolling block demand option, you need to specify a
subinterval.

Thermal demand

Thermal demand calculates the demand based on a thermal response, which
imitates the function of thermal demand meters.

The demand calculation updates at the end of each interval. You can set the
demand interval from 1 to 60 minutes (in 1-minute increments).

Thermal demand example

The following illustration shows the thermal demand calculation. In this example,
the interval is set to 15 minutes. The interval is a window of time that moves
across the timeline. The calculation updates at the end of each interval.

9% =
90% =

k—\ Last completed

demand interval

1
1
1

- 1

® 1

o

| 1

‘c 1

|

Time
I (minutes)
1
15-minute next
interval 15-minute
interval
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Peak demand

The meter records the peak (or maximum) values for kWD, kVARD, and kVAD
power (or peak demand).

The peak for each value is the highest average reading since the meter was last
reset. These values are maintained in the meter’s non-volatile memory.

The meter also stores the date and time when the peak demand occurred. In
addition to the peak demand, the meter also stores the coinciding average 3-
phase power factor. The average 3-phase power factor is defined as “demand kW/
demand kVA” for the peak demand interval.

Predicted demand

The meter calculates predicted demand for the end of the present interval for kW,
kVAR, and kVA demand, taking into account the energy consumption so far within
the present (partial) interval and the present rate of consumption.

Predicated demand is updated according to the update rate of your meter.

The following illustration shows how a change in load can affect predicted demand
for the interval. In this example, the interval is set to 15 minutes.

. >0
1:00 1:06 | 1:15
(E)
A Beginning of interval E Change in load
B Demand for last completed interval F Predicted demand if load is added
during interval; predicted demand
increases to reflect increased demand
15-minute interval G Predicted demand if no load is added
D Partial interval H Time

Setting up demand calculations

Use the Demand setup screens to define power or current demand.

Demand is a measure of average consumption over a fixed time interval.

1. Navigate to Maint > Setup.

2. Enter the setup password (default is “0000”), then press OK.
3. Navigate to Meter > Dmd.
4. Move the cursor to select Power Demand or Current Demand.
5. Move the cursor to point to the parameter you want to modify, then press
Edit.
Values Description
Method
Timed Sliding Block Select the appropriate demand calculation
method for your needs
Timed Block
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Power factor (PF)

Values Description

Timed Rolling Block
Cmd Sync Block
Cmd Sync Roll Block
Clock Sync Block
Clock Sync Roll Block
Input Sync Block
Input Sync Roll Block

Thermal

Interval

0-60 Set the demand interval, in minutes.
Subinterval

0-60 Applies only to rolling block methods.

Define how many subintervals the demand
interval should be equally divided into.

Select Dig Output

None Select which digital output the end of demand
interval pulse should be sent to.
Digital Output D1

Digital Output D2

Select Dig Input

None Applies only to input sync methods.
Digital Input S1 Select which digital input is used to sync the
demand.

Digital Input S2

Clock Sync Time

0-2359 Applies only to clock sync methods (these
synchronize the demand interval to the
meter’s internal clock).

Define what time of day you want to
synchronize the demand, from the start of the
day. For example, set this setting to 0730 to
synchronize demand at 7:30 AM.

6. Modify the parameter as required, then press OK.

7. Move the cursor to point to the next parameter you want to modify, press Edit,
make your changes, then press OK.

8. Press Yes to save your changes.

Power factor (PF) is the ratio of real power (P) to apparent power (S).

PF is provided as a number between -1 and 1 or as a percentage from -100% to
100%, where the sign is determined by the convention.

A purely resistive load has no reactive components, so its power factor is 1 (PF =
1, or unity power factor). Inductive or capacitive loads introduce a reactive power
(Q) component to the circuit which causes the PF to become closer to zero.
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True PF and displacement PF

The meter supports true power factor and displacement power factor values:
» True power factor includes harmonic content.

Displacement power factor only considers the fundamental frequency.

NOTE: Unless specified, the power factor displayed by the meter is true power
factor.

Real, reactive and apparent power (PQS)

A typical AC electrical system load has both resistive and reactive (inductive or
capacitive) components.

Real power, also known as active power (P) is consumed by resistive loads.

Reactive power (Q) is either consumed by inductive loads or generated by
capacitive loads.

Apparent power (S) is the capacity of your measured power system to provide real
and reactive power.

The units for power are watts (W or kW) for real power P, vars (VAR or kVAR) for
reactive power Q, and volt-amps (VA or kVA) for apparent power S.

+Q
(+KVAR, +KVARh)

A
Quadrant 2 90° Quadrant 1
PF leading PF lagging
Power factor sign convention: Power factor sign convention:
IEEE =+ IEEE = -
IEC=- IEC=+
g g
=73 =3
© 9 9
1 &3 §3
QT QT
—|_ 0D 03T
Z £ Z £
88 g2
¢ E ¢ E
Active power (W) Active power (W)
Exported/received Imported/delivered
P P
(-kw, -kWh)‘180o 0° " (+kW, +kWh)
7 Active power (W) Active power (W) T
< Exported/received Imported/delivered <
>0 >3
e 53
[ 23
(o= [ol=}
2 £ 2 £ I
O o o o
§¢ 5s
ow 0w
Quadrant 3 Quadrant 4
PF lagging PF leading
Power factor sign convention: Power factor sign convention:
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Power flow

Positive real power P(+) flows from the power source to the load. Negative real
power P(-) flows from the load to the power source.

Power factor sign convention

Power factor sign (PF sign) can be positive or negative, and is defined by the
conventions used by the IEEE or IEC standards.

You can set the power factor sign (PF sign) convention that is used on the display
to either IEC or IEEE.

PF sign convention: IEC

PF sign correlates with the direction of real power (kW) flow.
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* Quadrant 1 and 4: Positive real power (+kW), the PF sign is positive (+).
* Quadrant 2 and 3: Negative real power (-kW), the PF sign is negative (-).

PF sign convention: IEEE

PF sign is correlates with the PF lead/lag convention, in other words, the effective
load type (inductive or capacitive):

« For a capacitive load (PF leading, quadrant 2 and 4), the PF sign is positive
(+).
« Foraninductive load (PF lagging, quadrant 1 and 3), the PF sign is negative

()

Power factor register format

The meter provides power factor values in a variety of formats to suit your energy
management software.

Power factor in IEC and lead/lag (IEEE) formats: Float32 and Int16U registers

The meter provides total power factor in IEC and lead/lag (IEEE) formats in both
Float32 and Int16U data types. You can use these registers to bring power factor
information into third-party software. These registers are interpreted using the
standard IEC and IEEE sign conventions.

NOTE: For information on how to calculate actual power factor values from
the values in Int16U registers, see your meter’'s Modbus register list, available
from www.schneider-electric.com.

Four quadrant power factor information: floating point registers

The meter also provides PF information (including sign and quadrant) in single
floating point registers for each of the PF values (for example, per-phase and total
values for true and displacement PF, and associated minimums and maximums).
The meter performs a simple algorithm to the PF value then stores it in the
appropriate PF register.

The meter and software (such as Power Monitoring Expert or ION Setup) interpret
these PF registers for reporting or data entry fields according to the following
diagram:
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Quadrant 2
A<PF<0

-1

Quadrant 1
0<PF<1

+1

Quadrant 3
-1<PF<0

Quadrant 4
0<PF<1

PF value 0 to -1 -1to0 0to +1 +1t00
0 -1 0 +1 0
Quadrant 3 Quadrant 2 Quadrant 1 Quadrant 4
-2 -1 0 +1 +2
PF register 2to -1 1100 0to +1 +1t0 +2

Quadrant 2
-1 < PF register <0

-1 -

Quadrant 1
0 < PF register <1

+1

Quadrant 3
-2 < PF register < -1

Quadrant 4
2 < PF register <1

-2 42

The PF value is calculated from the PF register value using the following formulas:

Quadrant PF range PF register range PF formula

Quadrant 1 0to +1 0to +1 PF value = PF register
value

Quadrant 2 -1to 0 -1to0 PF value = PF register
value
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Timers

Operating Timer

Load Timer

/O timer

Quadrant PF range PF register range PF formula

Quadrant 3 0to-1 -2to-1 PF value = (-2) - (PF
register value)

Quadrant 4 +1t00 +1to +2 PF value = (+2) - (PF
register value)

Go to www.schneider-electric.com and search for your meter’s Modbus register
list to download a copy.

The meter supports an I/O timer, active load timer and an operating timer.

Use the meter display to navigate to the Timer and 1/O screens to view timer
information.

The operating timer (Timer > Oper) keeps track of how long the meter has been
powered up.

The load timer keeps track of how much time the input current exceeds the
specified load timer setpoint current.

The I/O timer shows how long an input or output has been ON.
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Meter resets

Meter Initialization

Resets allow you to clear various accumulated parameters stored on your meter
or reinitialize the meter or meter accessories.

Meter resets clear your meter’s onboard data logs and other related information.
Resets are typically performed after you make changes to the meter’s basic setup
parameters (such as frequency, VT/PT or CT settings) to clear invalid or obsolete
data in preparation for putting the meter into active service.

Meter Initialization is a special command that clears the meter’s logged data,
counters and timers.

It is common practice to initialize the meter after its configuration is completed,
before adding it to an energy management system.

After configuring all the meter setup parameters, navigate through the different
meter display screens and make sure the displayed data is valid then perform
meter initialization.

Performing global resets using the display

Global resets allow you to clear all data of a particular type, such as all energy
values or all minimum/maximum values.

1. Navigate to Maint > Reset.
2. Move the cursor to point to Global Reset, then press Select.

3. Move the cursor to point to the parameter you want to reset, then press

Reset.
Option Description
Meter Initialization Clears all data listed in this table (energy, demand, min/max
values, counters, logs and timers).
Energies Clears all accumulated energy values (kWh, kVARh, kVAh).
Demands Clears all the demand registers.
Min/Max Clears all the minimum and maximum registers.
Alarm Counts & Logs Clears all the alarm counters and alarm logs.
1/0 Counts & Timers Clears all the I/0 counters and resets all the timers.

4. Enter the reset password (default is “0”), then press OK.

5. Press Yes to confirm the reset or No to cancel and return to the previous
screen.

To perform resets using ION Setup, see the “PM5300” topic in the ION Setup
online help or in the ION Setup device configuration guide, available from
www.schneider-electric.com.

Performing single resets using the display

Single resets allow you clear data only in a specific register or register type.
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Available single resets using the display

Single resets are often combined to allow you to clear all data of a similar type, for
example, a kWh, kVAR and kVA reset may be combined into an energy reset that
clears all of the meter’s energy logs.

1. Navigate to Maint > Reset.

2. Move the cursor to point to Single Reset, then press Select.

3. Move the cursor to point to the parameter you want to reset, then press

Reset.

If there are additional options for the parameter, press Select, move the
cursor to point to the option you want, then press Reset.

4. Enter the reset password (default is “0”), then press OK.

5. Press Yes to confirm the reset or No to cancel and return to the previous

screen.

Parameter Option Description
Energy Accumulated Clears all accumulated energy values (kWh, kVARh, kVAh).
Demand Power, Current Select which demand registers to clear (power demand or current
demand).
Alarms Event Queue Clears the alarm event queue register (active alarms list).
History Log Clears the alarm history log.
Counters Select Counters and then select which alarm counter to clear. See the
Alarm counter reset options table.
Status Inputs Timers Select Timers then select which status input timer to clear (chose all or
individual status input timers)
Counters Select Counters then select which status input counter to clear (chose all
or individual status input timers)
Digital Outputs Timers Select Timers then select which digital output timer to clear (chose all or
individual digital output timers)
Counters Select Counters then select which digital output counter to clear (chose all

or individual digital output timers)

Active Load Timer

Clears and restarts the load operation timer.

Multi-Tariff

Clears accumulated values in all tariff registers.

To perform resets using ION Setup, see the “PM5300” topic in the ION Setup
online help or in the ION Setup device configuration guide, available from
www.schneider-electric.com.
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Multi-tariffs

Multi-tariff

The multi-tariff feature allows you to set up different tariffs for storing energy
values.

The energy values for different tariffs are stored in registers that correspond to
each of those tariffs.

Multi-tariff example

The multi-tariff feature can be used when a utility has set up tariff schedules with
different rates based on what day or time of day energy is consumed.

Power
P
Time
X
Cost
$
Tariff energy containers
di

—
N

In the above illustration, the area under the power curve equals the energy
consumed.

Typically, the utility sets tariff schedules so the cost of energy is higher during high
demand or high energy consumption times. How these “tariff energy containers”
are configured determines how fast these containers fill, which correlates to
increasing energy costs. The price per kWh is lowest at tariff T1 and highest at
tariff T2.

Multi-tariff implementation

The meter supports configuration of up to 4 different tariffs to measure and
monitor energy usage that can be used in billing or cost applications.

There are three different tariff modes you can use to activate the multi-tariff
registers:

+ Command mode
» Time of Day mode
* Input mode

Active tariff control mode

The active tariff is controlled based on the tariff mode.

»  When the meter is set to command mode, the active tariff is controlled by the
Modbus commands from your energy management system or other Modbus
master.
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»  When the meter is set to input mode, the active tariff is controlled by the
status of the digital inputs.

+  When the meter is set to time of day mode, the active tariff is controlled by the
day type, the start and end times, and the start and end dates.

Command mode overview

You can use command mode to send a Modbus command to the device which
sets the active tariff.

The active tariff is applied to the measured energy until you send another Modbus
command that sets a different tariff.

Search for your meter’'s Modbus register list at www.schneider-electric.com to
download the Modbus map.

Time of day mode overview

You can use time of day mode to create a tariff schedule that specifies where the
meter stores energy or input metered data, based on the time of year (month,
day), the type of day (every day, weekend, weekday or a specific day of the week),
or time of day.

The data collected from the different tariffs can then be used in energy audits or
similar costing and budget planning purposes.

Time of day mode tariff validity

A valid time of day tariff has certain conditions and limitations:

» Each tariff must cover a unique time period (tariffs cannot overlap), but there
can be periods with no tariff.

* Any number of tariffs, from none to the maximum number of tariffs, can be
applied.

» Time of day tariffs do not adjust for daylight savings time.

« Time of day tariffs include February 29th in leap years (however, it is not
recommended to have February 29th as a start or end date, as that tariff
would be invalid for non-leap years.

+ Except for leap years, tariff dates are not year-specific; if you wanted to
create a tariff that starts on the first Monday in August, you need to enter the
date for that year, then manually update the tariff information for the
subsequent years.

Your device performs validation checks as you enter tariff information; it prompts
you to change the information that you have entered or set the tariff to disabled if
the tariff configuration is invalid. These checks can include:

+ Start and end times must be different (for example, you cannot create a tariff
that starts at 02:00 and also ends at 02:00).

« Start time can only be earlier than end time for tariffs that are applied every
day. You can create a daily tariff that starts at 06:00 and ends at 02:00, but
these times are only valid for the Everyday tariff and invalid for the other tariff
types.

« Start day must be earlier than end day if the days are in the same month. You
cannot create a tariff that starts June 15 and ends June 12.

Time of day tariff creation methods

You can create time of day tariffs using one of the two methods, or a combination
of these methods:
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» Time of year tariffs divide the year into multiple sections (usually seasons),
where each section has one or more day types. For example, a four tariff
configuration using this method could have Summer and Winter seasons that
also use different weekend and weekday tariffs.

« Daily tariffs can divide days by day of the week, a weekday, a weekend, or
every day, and can specify the time of day. For example, a four tariff
configuration could have every day in the year divided into six-hour tariff
periods or could have two tariffs for weekends and two tariffs for weekdays.

You can combine these methods if, for example you wanted to create a tariff that
applies on Mondays from January 1 to June 30, from 09:00 to 17:00. However,
since only one tariff can be applied at any time, you cannot use an everyday or
weekday tariff type because you already specified a tariff for the time periods
09:00 to 17:00.

Depending on how you configure the tariffs and the maximum number of tariffs
supported by your meter, you may not be able to assign tariffs for the entire year,
potentially leaving time gaps that do not have any tariff assigned to them.

Example tariff configurations for a four-tariff system

In these examples, four tariffs are used to cover the entire year (there are no time
periods that do not have an associated tariff).

Configuration 1: four tariffs with weekdays and weekends

Tariff Type Start date End date Start time End time
1 Weekend June 21 December 20 | 00:00 23:59
2 Weekend December 21 | June 20 00:00 23:59
3 Weekday June 21 December 20 | 00:00 23:59
4 Weekday December 21 | June 20 00:00 23:59

NOTE: The end time of 23:59 is actually 23:59:59, or just before midnight.

All weekend days fall into one of two different tariffs, depending on the date. All
weekdays fall into one of two different tariffs, depending on the date. This
configuration does not use tariffs based on the time of day, or any day types other
than weekend or weekday.
Example dates and corresponding tariffs:

+ Friday, June 29 = tariff 3

* Sunday, November 28th = tariff 1

Configuration 2: one season for weekends, with off-peak and shoulder hours, two
seasons for weekdays, with shoulder hours

Tariff Type Start date End date Start time End time
1 Every day January 1 December 31 | 23:00 04:59
2 Weekdays May 1 September 20 | 00:00 22:59
3 Weekdays October 1 April 30 05:00 22:59
4 Weekends January 1 December 31 | 05:00 22:59

All days have a tariff applied between 23:00 and 04:59, corresponding to off-peak
hours. All weekend days have a tariff applied from 05:00 to 22:59, corresponding
to shoulder hours. All weekdays fall into one of two seasons (summer or winter),
and have two tariffs applied throughout the day.

Example dates and corresponding tariffs:
»  Wednesday, March 21, 08:00 = tariff 3
» Tuesday, January 10, 21:00 = tariff 3
» Sunday, June 24, 14:00 = tariff 4
» Friday, August 17, 00:00 = tariff 1
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Configuring time of day mode tariffs using the display

When the meter is set to time of day for tariffs, the active tariff is determined by the
day type, the start and end times, and the start and end dates.

The time of day tariff is not a calendar; the meter does not calculate the
corresponding day of the week to a specific date, but February 29th is considered
a valid date if you are programming the meter during a leap year.

When you enter tariff times using the front panel, be aware that the displayed
minute value includes the entire minute. For example, an end time of 01:15
includes the time from 01:15:00 through 01:15:59. To create a tariff period that
starts right after this, you must set the next tariff start time to 01:16. Although it
may appear that there is a gap between these tariffs, there is not.

1. Navigate to Maint > Setup.

Enter the setup password (default is “0”), then press OK.
Navigate to Meter > Tariff.

Select Mode and press Edit.

Press + or - to change the setting to Time of Day, then press OK.

2 T

Move the cursor to point to the tariff (Tariff 1 to Tariff 4) you want to modify,
then press Edit.

Parameter Values Description

Day Type Everyday, Weekday, Select which day the tariff is
Weekend, Monday, Tuesday, | active. Only tariffs that are
Wednesday, Thursday, Everyday can have a tariff

Friday, Saturday or Sunday that includes midnight (for
instance, from 11pm to 2am).

Start Time 0000 to 2359 Set the time when the tariff
period starts, using the 24
hour clock format (00:00 to
23:59). The Start Time
cannot equal the End Time.

End Time 0000 to 2359 Set the time when the tariff
period ends, using the 24
hour clock format (00:00 to
23:59). The End Time cannot
equal the Start Time.

Start Month 1to 12 Set the month that the tariff
period starts, where 1 =
January, 2 = February, 3 =
March, 4 = April, 5= May, 6 =
June, 7 = July, 8 = August, 9
= September, 10 = October,
11 = November, 12 =
December.

Start Day 110 31 Set the day of the Start
Month that the tariff period
starts. The Start Day must be
earlier than End Day if Start
Month equals End Month.

End Month 1t012 The month that the tariff
period ends, where 1 =
January, 2 = February, 3 =
March, 4 = April, 5 =May, 6 =
June, 7 = July, 8 = August, 9
= September, 10 = October,
11 = November, 12 =
December.

End Day 110 31 The day of the End Month
that the tariff period ends.

7. Modify each parameter as required, then press OK to set.

Press the Up and Down arrow buttons to move between parameters.
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8. Press the Up arrow to exit, then Yes to save your changes.
Repeat for the other tariffs as required.

The meter checks the configuration and display a message if any tariffs have
conflicting settings (overlapping tariff periods for example).

Input mode overview

You can use input mode to have the digital inputs of the device set to know which
tariff is applied to the energy that is presently being consumed.

The number of different tariffs that can be applied is determined by the number of
available digital inputs and the total number of tariffs supported by your device.

Digital input assignment for input control mode

You need to assign one or more digital inputs with non-exclusive associations to
define the active tariff.

If a digital input is used for multi-tariff, it cannot be used for an exclusive
association (such as Demand Sync), but digital inputs can be shared with a non-
exclusive association (such as Alarms). To make a digital input available for
setting tariffs, any conflicting associations must be manually removed at the
source of the original association.

The digital inputs are used as binary counters to identify the appropriate tariff,
where off = 0 and on = 1, and most significant bit (MSB) is digital input 2 and least
significant bit (LSB) is digital input 1. By this definition, digital input 1 must be
associated with the multi-tariff feature in order to set the tariff to Input mode.

Digital input requirements for required number of tariffs

Number of
tariffs required

Digital inputs required

Configuration 1 Configuration 2
1 1 (digital input 1) 1 (digital input 1)
2 1 (digital input 1) 2 (digital input 1 and 2)
3 2 (digital input 1 and 2) 2 (digital input 1 and 2)
4 2 (digital input 1 and 2) 2 (digital input 1 and 2)

Configuration 1: 2 tariff assignment using 2 digital inputs

NOTE: There is no inactive tariff with this configuration.

Tariff Digital input 2 Digital input 1
T1 0 0
T2 0 1

Configuration 2: 2 tariff assignment using 2 digital inputs

NOTE: Digital input configuration 00 means that there are no active tariffs (all
tariffs are disabled).

Tariff Digital input 2 Digital input 1
None 0 0
T1 0 1
T2 1 0
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Configuring input mode tariffs using the display

Use the display to configure input mode tariffs. You can also configure input mode
tariffs using ION Setup.

You cannot configure any digital input tariff if digital input 1 is not available for
association. Likewise, digital input 2 must be available to select more than two
tariffs.

The status of the digital inputs is used to calculate the binary value of the active
tariff, where off = 0 and on = 1. The calculation of the number of tariffs value can
differ, depending on the number of digital inputs that can be selected (i.e., inputs
that can be associated with multi-tariff).

o > 0N

. Navigate to Maint > Setup.

Enter the setup password (default is “0”), then press OK.
Navigate to Meter > Tariff.
Select Mode and press Edit.

Press + or - to change the setting to Input, then press OK.

NOTE: If a digital input association error prompt displays, you must exit
from the tariff setup screens and remove the digital input association.

6. Navigate to Tariffs, then press Edit.

Press + or - to change the number of tariffs you want to set up and press OK.

The maximum number of tariffs that you can apply is determined by the
number of available digital inputs.

. Navigate to Inputs, then press Edit.

If applicable, press + or - to change how many digital inputs you want to use
to control which tariff is selected (active). Press OK.

Press the up arrow to exit, then Yes to save your changes.
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Power quality measurements

The meter provides harmonic distortion metering up to the 31st harmonic.

The following power quality measurements are available:
* Individual harmonics (odd harmonics up to 31st)

» Total harmonic distortion (THD, thd) for current and voltage (line-to-line, line-
to-neutral)

» Total demand distortion (TDD)
The following harmonics data is available on the display:
» Numeric magnitude and angle of the fundamental (first) harmonic.

» Graphical display of the 3rd to 31st harmonics, expressed as a percentage of
the fundamental harmonic.

Harmonics overview

Harmonics are integer multiples of the fundamental frequency of the power
system.

Harmonics information is valuable for power quality analysis, determining properly
rated transformers, maintenance and troubleshooting. Evaluation of harmonics is

required for compliance to system power quality standards such as EN50160 and

meter power quality standards such as IEC 61000-4-30.

Harmonics measurements include per-phase magnitudes and angles (relative to
the fundamental frequency of the phase A voltage) for the fundamental and higher
order harmonics relative to the fundamental frequency. The meter’s power system
setting defines which phases are present and determines how line-to-line or line-
to-neutral voltage harmonics and current harmonics are calculated.

Harmonics are used to identify whether the supplied system power meets required
power quality standards, or if non-linear loads are affecting your power system.
Power system harmonics can cause current flow on the neutral conductor, and
damage to equipment such as increased heating in electric motors. Power
conditioners or harmonic filters can be used to minimize unwanted harmonics.

Total harmonic distortion

Total harmonic distortion (THD) is a measure of the total per-phase voltage or
current harmonic distortion present in the power system.

THD provides a general indication of the quality of a waveform. THD% is
calculated for each phase of both voltage and current.

Total demand distortion

Total demand distortion (TDD) is the per-phase harmonic current distortion against
the full load demand of the electrical system.

TDD indicates the impact of harmonic distortion in the system. For example, if
your system is showing high THD values but a low demand, the impact of
harmonic distortion on your system might be insignificant. However at full load, the
THD value for the current harmonics is equal to TDD, so this could negatively
impact your system.
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Harmonic content calculations

Harmonic content (Hc) is equal to the RMS value of all the non-fundamental
harmonic components in one phase of the power system.

The meter uses the following equation to calculate Hc:

HC = (H,)? + (H)? + (H,)? ...

THD% calculations

THD% is a quick measure of the total distortion present in a waveform and is the
ratio of harmonic content (Hc) to the fundamental harmonic (H1).

By default, the meter uses the following equation to calculate THD%:

HC
THD = —€ x100%
H1

thd calculations
thd is an alternate method for calculating total harmonic distortion that uses the
RMS value for the total harmonic content rather than the fundamental content.
The meter uses the following equation to calculate thd:

thd = ——HC 100

J(H1)2 + (HC)?

TDD calculations
TDD (total demand distortion) evaluates the harmonic currents between an end
user and a power source.

The harmonic values are based on a point of common coupling (PCC), which is a
common point where each user receives power from the power source.

The meter uses the following equation to calculate TDD:

TDD = (J/(HCIA)? + (HCIB)? + (HCIC)?) / (ILoad) x 100
Where ILoad is equal to the maximum demand load on the power system.

Viewing harmonics using the display

You can view harmonics data using the display.

1. Navigate to Harm.

The Harmonics % screen displays.
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2. Press the voltage or current harmonics you want to view.

IEEE mode IEC mode Description

V L-L U Line-to-line voltage harmonics data

V L-N \% Line-to-neutral voltage harmonics data
Amps | Current harmonics data

TDD TDD Total demand distortion data

The fundamental (1st) harmonics numeric magnitudes and angles for all
phases are displayed.

3. Press 3—11, 13-21, or 21-31 to view the graphs for the 3rd to the 11th, 13th
to 21st, or 23rd to 31st harmonics, respectively.

For example, to display the 13th to 21st harmonics screen, press 13-21.

_ BRI

-5 006

35

13 15 17 19 21
& 13-2123-31 p

A | Phase A ‘ B ‘ Phase B | C ’ Phase C

The vertical axis of the harmonics graph indicates the harmonic’s magnitude
as a percentage of the fundamental harmonic, and is scaled based on the
largest harmonic displayed. At the top of each vertical bar is a marker that
shows the maximum value of the harmonic. If the harmonic is greater than the
fundamental harmonic, this marker is triangular-shaped to show that the
value is out of range.

Viewing TDD using the display

The meter display provides screens that show TDD values.

NOTE: Your meter’'s Modbus map includes registers for harmonics data for
integration into your power or energy management system. Search PM5300
Modbus register list at www.schneider-electric.com to download the Modbus
map.

1. Navigate to Harm > TDD.
The TDD information displays.

2. Press the up arrow to return to the main display screens.

Viewing THD/thd using the display

You can view THD/thd data using the display.

NOTE: Your meter’'s Modbus map includes registers for total harmonic
distortion data for integration into your power or energy management system.
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1. Navigate to THD to view the THD/thd Select screen.

2. Press THD to display values that use the calculation method based on the
fundamental harmonic or thd to display values that use the calculation

method based on the RMS value of all harmonics in that phase (including the

fundamental).

IEEE mode IEC mode Description

Amps | Total harmonic distortion data for per phase
and neutral currents.

V L-L U Total harmonic distortion data line-to-line
voltage.

V L-N \% Total harmonic distortion data line-to-neutral
voltage.

3. Press the current or voltage THD or thd values you want to view.

The total harmonic distortion percentage values are displayed.

4. Press the up arrow to return to the main display screens.
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Maintenance overview

The meter does not contain any user-serviceable parts. If the meter requires
service, contact your local Schneider Electric Technical Support representative.

NOTICE

METER DAMAGE
+ Do not open the meter case.
» Do not attempt to repair any components of the meter.

Failure to follow these instructions can result in equipment damage.

Do not open the meter. Opening the meter voids the warranty.

Lost user access

If you lose your meter’s user access (password) information, contact your local
Schneider Electric representative for instructions on how to return your meter for
factory reconfiguration.

NOTE: Have your meter’s serial number available for reference.

Power meter memory

The meter uses its nonvolatile memory to retain data and metering configuration
values.

Under the operating temperature range specified for the power meter this
nonvolatile memory has an expected life of at least 45 years.

NOTE: Life expectancy is a function of operating conditions and does not
constitute any expressed or implied warranty.

Firmware version, model and serial number

You can view the meter’s firmware version (including OS, RS and Ethernet
versions), model and serial number from the display panel or through the meter
webpages.

* Using the display panel: Navigate to Maint > Diag > Info.
» Using the meter webpages: Navigate to Diagnostics > Meter Information.

NOTE: For MID compliance, the firmware upgrade functionality is
permanently disabled on MID models. The OS CRC value is a number that
identifies the uniqueness between different OS firmware versions.

Firmware upgrades

The power meter supports the downloading of new firmware and language files
over the communications link.

This requires the free DLF3000 software, which is available at
www.schneider-electric.com. The DLF3000 offers an extensive Help file with
information on operating the software. The most recent firmware and language
files are also available on the website. Recommended baud rate for firmware
download through communications link is 19200.
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Upgrading your meter using DLF3000

You can use the DLF3000 upgrade utility, available from
www.schneider-electric.com, to upgrade your meter’s firmware files.

Before you begin, download the necessary files from www.schneider-electric.com:
+ Download the latest version of DLF3000 then install it on your computer.
+ Download your meter’s firmware.

To see if there are firmware upgrades available for your meter, search for your
meter at www.schneider-electric.com

1. Start DLF3000.
2. Click Add/Update.

3. Navigate to the folder where you saved your meter’s firmware then select the
firmware file and click Open.

4. Click Next.
5. Select a system to upgrade, or click New to define a new system.

6. Define the communications connection (click Add to create a new connection
or Configure to update an existing connection).

a. Type in the box to assign a communications connection name and select
a communications driver from the dropdown list (Modbus/TCP Driver or
Serial Driver).

b. Click Continue.

A dialog box appears where you need to provide the communications
information for the meter.

» If you are using Modbus over TCP to upgrade, type the meter’s IP
address in the box.

» If you are using a serial connection, enter the information on how
your meter is connected (such as communications wiring, parity,
port, address).

c. Click OK.
7. Define the devices to upgrade.
a. Click Add.
b. Type in a device name.
c. Select the device type from the list.

d. Select the connection name for the communications connection used
with the device (the one you defined in the previous step).

e. Click OK.
f. Enterin the device address and protocol information then click OK.
8. Click Next.

9. Select the device name from the Download Candidate Devices pane, then
click the right arrow button to move the selection to the Download Target
Devices pane.

10. Select the meter firmware in the Firmware to field.
11. Click Next.
12. Click Health Check to confirm the meter is communicating.

The Health Status shows Passed to indicate successful communications.
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13. Click Next.

The Firmware Update Group shows the connection name, the firmware
version and status (should be “Queued”). The Group Device List shows the
device or devices being upgraded.

14. Click Download.

NOTE: A warning message displays, “Warning: Relays on PowerLogic
Metering Devices will be de-energized if selected for download and will
remain in this mode until a successful download is completed. Press OK
to start the download.”

15. Click OK.

» The Firmware Upgrade Group status changes to Active, then updates to
show the current upgrade progress (in percent complete).

» The Group Device List status shows “Entering Download Mode”, then
changes to “Downloading” when the firmware is being downloaded to the
meter. “Estimated Time Remaining” shows the firmware download
progress.

* You can also check the progress on meters equipped with a display
panel. The meter display shows “Download in progress” and a shows a
dynamically incrementing number for “Percent Complete” (up to 100%).

When the firmware upgrade is complete, the Firmware Update Group status
shows Complete (Passed). The Group Device List status shows Successful
Download.

16. Click Finished.

To exit the download firmware program, click Yes when prompted to quit DLF.

Diagnostics information

The meter provides you with diagnostics information to help with troubleshooting.

The display provides meter status and loss of control power screens.

Troubleshooting

Troubleshooting LED indicators

Abnormal heartbeat / serial communications LED behavior could mean potential
problems with the meter.

Problem Probable causes Possible solutions

LED flash rate does not
change when data is sent from
the host computer.

Communications wiring If using a serial-to-RS-485
converter, trace and check that
all wiring from the computer to
the meter is properly

terminated.

Perform a hard reset: turn off
control power to the meter,
then re-apply power. If the
problem persists, contact
Technical Support.

Internal hardware problem

Heartbeat / serial Internal hardware problem Perform a hard reset: turn off

communications LED remains
lit and does not flash ON and
OFF

control power to the meter,
then re-apply power. If the
problem persists, contact
Technical Support.

Heartbeat / serial
communications LED flashes,
but the display is blank.

Display setup parameters
incorrectly set

Review display parameter
setup.
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If the problem is not fixed after troubleshooting, contact Technical Support for
help. Make sure you have your meter’s firmware version, model and serial number
information available.

Troubleshooting checks

There are some checks you can perform to try to identify potential issues with the
meter’s operation.

The following table describes potential problems, their possible causes, checks
you can perform or possible solutions for each. After referring to this table, if you
cannot resolve the problem, contact your local Schneider Electric sales
representative for assistance.

ADANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

» Apply appropriate personal protective equipment (PPE) and follow safe
electrical work practices. See NFPA 70E in the USA, CSA Z462 or
applicable local standards.

« Turn off all power supplying this device and the equipment in which it is
installed before working on the device or equipment.

« Always use a properly rated voltage sensing device to confirm that all power
is off.

» Treat communications and I/O wiring connected to multiple devices as
hazardous live until determined otherwise.

* Do not use the data from the meter to confirm power is off.
Failure to follow these instructions will result in death or serious injury.

Potential problem Possible cause Possible solution

The maintenance (wrench) When the maintenance Go to Maint > Diag. Event

icon is illuminated on the (wrench) icon is illuminated, it messages display to indicate

power meter display. indicates an event has the reason the icon is
occurred which may require illuminated. Note these event
attention. messages and call the

Technical Support or contact
your local sales representative
for assistance.

The display is blank after The power meter may not be The display may have timed
applying control power to the receiving the necessary power. | out. Verify that the power meter
power meter. line and terminals are receiving

the necessary power. Verify
that the heartbeat LED is
blinking. Press a button to see
if the display timed out.

The data being displayed is » Incorrect setup values. » Check that the correct
inaccurate or not what you - Incorrect voltage inputs. values have been
expect. s entered for power meter
+  Power meter is wired setup parameters (CT
improperly and VT ratings, Nominal

Frequency, and so on).

*  Check power meter
voltage input terminals
(1, 2, 3, 4) to verify that
adequate voltage is
present.

* Check thatall CTs and
VTs are connected
correctly (proper polarity
is observed) and that
they are energized.
Check shorting terminals.
See the recommended
torque in the Wiring
section of the installation
manual.
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Potential problem

Possible cause

Possible solution

Cannot communicate with
power meter from a remote
personal computer.

Power meter address is
incorrect.

Power meter baud rate is
incorrect.

Communications lines
are improperly
connected.

Communications lines
are improperly
terminated.

Incorrect route statement
to power meter.

Check to see that the
power meter is correctly
addressed.

Verify that the baud rate
of the power meter
matches the baud rate of
all other devices on its
communications link.

Verify the power meter
communications
connections.

Check to see that a multi-
point communications
terminator is properly
installed.

Check the route
statement. Contact
Global Technical Support
for assistance.

Energy/Alarm LED not
working.

May have been disabled by

user.

Confirm that the energy / alarm
LED is configured correctly.

Technical assistance

Visit www.schneider-electric.com for support and assistance with lost passwords
or other technical problems with the meter.

Make sure you include your meter’'s model, serial number and firmware version in
your email or have it readily available if calling Technical Support.
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Overview of meter accuracy

All meters are tested and verified at the factory in accordance with International
Electrotechnical Commission (IEC) and American National Standards Institute
(ANSI) standards.

Your digital power meter typically does not require re-calibration. However, in
some installations a final accuracy verification of the meters is required, especially
if the meters will be used for revenue or billing applications.

Accuracy test requirements

The most common method for testing meter accuracy is to apply test voltages and
currents from a stable power source and compare the meter’s readings with
readings from a reference device or energy standard.

Signal and power source

Control equipment

Environment

The meter maintains its accuracy during voltage and current signal source
variations but its energy pulsing output needs a stable test signal to help produce
accurate test pulses. The meter’s energy pulsing mechanism needs
approximately 10 seconds to stabilize after every source adjustment.

The meter must be connected to control power in order to conduct accuracy
verification testing. Refer to your meter’s installation documentation for power
supply specifications.

ADANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

Verify the device’s power source meets the specifications for your device’s
power supply.

Failure to follow these instructions will result in death or serious injury.

Control equipment is required for counting and timing the pulse outputs from an
energy pulsing LED or digital output.

* Most standard test benches have an arm equipped with optical sensors to
detect LED pulses (the photodiode circuitry converts detected light into a
voltage signal).

» The reference device or energy standard typically has digital inputs that can
detect and count pulses coming from an external source (i.e., the meter’s
digital output).

NOTE: The optical sensors on the test bench can be disrupted by strong
sources of ambient light (such as camera flashes, florescent tubes, sunlight
reflections, floodlights, etc.). This can cause test errors. Use a hood, if
necessary, to block out ambient light.

The meter should be tested at the same temperature as the testing equipment.
The ideal temperature is about 23 °C (73 °F). Make sure the meter is warmed up
sufficiently before testing.
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A warm-up time of 30 minutes is recommended before beginning energy accuracy
verification testing. At the factory, the meters are warmed up to their typical
operating temperature before calibration to help ensure that the meters will reach
their optimal accuracy at operating temperature.

Most high precision electronic equipment requires a warm up time before it
reaches its specified performance levels. Energy meter standards allow the
manufacturers to specify meter accuracy derating due to ambient temperature
changes and self-heating.

Your meter complies with and meets the requirements of these energy metering
standards.

For a list of accuracy standards that your meter complies to, contact your local
Schneider Electric representative or download the meter brochure from
www.schneider-electric.com.

Reference device or energy standard

To help ensure the accuracy of the test, it is recommended that you use a
reference device or reference energy standard with a specified accuracy that is 6
to 10 times more accurate than the meter under test. Before you start testing, the
reference device or energy standard should be warmed up as recommended by
its manufacturer.

NOTE: Verify the accuracy and precision of all measurement equipment used
in accuracy testing (for example, voltmeters, ammeters, power factor meters).

Energy pulsing

You can configure the meter’s alarm /energy LED or one of the digital outputs for
energy pulsing.

* The meter is equipped with an alarm / energy pulsing LED. When configured
for energy pulsing, the LED emits pulses that are then used to determine the
accuracy of the meter’s energy measurements.

» The meter is equipped with digital outputs. When you configure a digital
output for energy pulsing, the meter sends voltage pulses to the digital output
port, which are then used to determine the accuracy of the meter’s energy
measurements.

Meter settings for accuracy testing

Your meter‘s power system and other parameters must be configured for accuracy

testing.
Meter parameter Value
Power system 3PH4W Wye Gnd (3-phase, 4 wire Wye with
ground)
Energy pulse constant In sync with reference test equipment
(alarm/energy pulsing LED or digital output)

Verifying accuracy test

The following tests are guidelines for accuracy testing your meter; your meter
shop may have specific testing methods.
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ADANGER

HAZARD OF ELECTRIC SHOCK, EXPLOSION, OR ARC FLASH

* Apply appropriate personal protective equipment (PPE) and follow safe
electrical work practices. See NFPA 70E in the USA, CSA Z462 or
applicable local standards.

» Turn off all power supplying this device and the equipment in which it is
installed before working on the device or equipment.

» Always use a properly rated voltage sensing device to confirm that all power
is off.

» Do not exceed the device’s ratings for maximum limits.

» Verify the device’s power source meets the specifications for your device’s
power supply.

Failure to follow these instructions will result in death or serious injury.

1. Turn off all power supplying this device and the equipment in which it is
installed before working on the device or equipment.

2. Use a properly rated voltage sensing device to confirm that all power is off.

3. Connect the test voltage and current source to the reference device or energy
standard. Ensure all voltage inputs to the meter under test are connected in
parallel and all current inputs are connected in series.

" 12 13
V1V2V3VN
+ - F - + -

X2X=X% PEPPED

@ vijvafvavn v _l2 fis
[eooa PODOOD

V1V2V3VN

Xxx: dooed®
(C/

A | Reference device or energy standard

Test voltage and current source

C | Meter under test

4. Connect the control equipment used for counting the standard output pulses
using one of these methods:

Option Description

Energy pulsing LED Align the red light sensor on the standard test bench armature over
the energy pulsing LED.

Digital output Connect the meter’s digital output to the standard test bench pulse
counting connections.

NOTE: When selecting which method to use, be aware that energy
pulsing LEDs and digital outputs have different pulse rate limits.

5. Before performing the verification test, let the test equipment power up the
meter and apply voltage for at least 30 seconds. This helps stabilize the
internal circuitry of the meter.

6. Configure the meter’s parameters for verifying accuracy testing.
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7. Depending on the method selected for counting the energy pulses, configure
the meter’s energy pulsing LED or one of the digital outputs to perform energy
pulsing. Set the meter’s energy pulse constant so it is in sync with the
reference test equipment.

8. Perform accuracy verification on the test points. Run each test point for at
least 30 seconds to allow the test bench equipment to read an adequate
number of pulses. Allow 10 seconds of dwell time between test points.

Required pulses calculation for accuracy verification testing

Accuracy verification test equipment typically requires you to specify the number
of pulses for a specific test duration.

The reference test equipment typically requires you to specify the number of
pulses required for a test duration of “t” seconds. Normally, the number of pulses
required is at least 25 pulses, and the test duration is greater than 30 seconds.

Use the following formula to calculate the required number of pulses:
Number of pulses = Ptot x K x /3600

Where:
» Ptot = total instantaneous power in kilowatts (kW)
+ K =the meter’s pulse constant setting, in pulses per kWh
+ t=testduration, in seconds (typically greater than 30 seconds)

Total power calculation for accuracy verification testing

Accuracy verification testing supplies the same test signal (total power) to both the
energy reference/standard and the meter under test.

Total power is calculated as follows, where:
» Ptot = total instantaneous power in kilowatts (kW)
* VLN = test point line-to-neutral voltage in volts (V)
» | =test point currentin amps (A)
» PF = power factor
The result of the calculation is rounded up to the nearest integer.

For a balanced 3—phase Wye system:

Ptot = 3 x VLN x | x PF x 1 kW/1000 W

NOTE: A balanced 3—phase system assumes that the voltage, current and
power factor values are the same for all phases.

For a single-phase system:

Ptot = VLN x | x PF x 1 kW/1000W

Percentage error calculation for accuracy verification testing

Accuracy verification testing requires you to calculate the percentage error
between the meter being tested and the reference/standard.

Calculate the percentage error for every test point using the following formula:
Energy error = (EM - ES) / ES x 100%
Where:

* EM = energy measured by the meter under test

+ ES = energy measured by the reference device or energy standard.

NOTE: If accuracy verification reveals inaccuracies in your meter, they may be
caused by typical sources of test errors. If there are no sources of test errors
present, please contact your local Schneider Electric representative.
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Accuracy verification test points

The meter should be tested at full and light loads and at lagging (inductive) power
factors to help ensure testing over the entire range of the meter.

The test amperage and voltage input rating are labeled on the meter. Refer to the
installation sheet or data sheet for your meter’s nominal current, voltage and
frequency specifications.

Watt-hour test point Sample accuracy verification test point

Full load 100% to 200% of the nominal current, 100% of the nominal voltage and
nominal frequency at unity power factor or one (1).

Light load 10% of the nominal current, 100% of the nominal voltage and nominal
frequency at unity power factor or one (1).

Inductive load (lagging | 100% of the nominal current, 100% of the nominal voltage and nominal
power factor) frequency at 0.50 lagging power factor (current lagging voltage by 60°
phase angle).

VAR-hour test point Sample accuracy verification test point

Full load 100% to 200% of the nominal current, 100% of the nominal voltage and
nominal frequency at zero power factor (current lagging voltage by 90°
phase angle).

Light load 10% of the nominal current, 100% of the nominal voltage and nominal
frequency at zero power factor (current lagging voltage by 90° phase
angle).

Inductive load (lagging | 100% of the nominal current, 100% of the nominal voltage and nominal
power factor) frequency at 0.87 lagging power factor (current lagging voltage by 30°
phase angle).

Energy pulsing considerations

The meter’s alarm / energy LED and digital outputs are capable of energy pulsing
within specific limits.

Description Alarm / energy LED Digital output
Maximum pulse frequency 2.5kHz 25 Hz
Minimum pulse constant 1 pulse perk_h

Maximum pulse constant 9,999,999 pulses per k_h

The pulse rate depends on the voltage, current and PF of the input signal source,
the number of phases, and the VT and CT ratios.

If Ptot is the instantaneous power (in kW) and K is the pulse constant (in pulses
per k_h), then the pulse period is:

3600 _ 1
KX Ptot Pulse frequency (Hz)

Pulse period (in seconds) =

VT and CT considerations
Total power (Ptot) is derived from the values of the voltage and current inputs at
the secondary side, and takes into account the VT and CT ratios.

The test points are always taken at the secondary side, regardless of whether VTs
or CTs are used.

If VTs and CTs are used, you must include their primary and secondary ratings in
the equation. For example, in a balanced 3-phase Wye system with VTs and CTs:
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VT CT 1 kKW
Ptot = 3 x VLN P —£ _
tot =3 X VTSXIXCTSXPFX1OOOW

where Ptot = total power, VT, = VT primary, VTs = VT secondary, CT, = CT
primary, CTs = CT secondary and PF = power factor.

Total power limits

There are limits to the total power that the alarm / energy pulsing LED and the
digital output can handle.

Total power limit for alarm / energy LED

Given the maximum pulse constant (Kmax) you can enter is 9,999,999 pulses per
kWh, and the maximum pulse frequency for the alarm / energy LED is 83 Hz, the
maximum total power (Max Ptot) the alarm / energy LED’s energy pulsing circuitry
can handle is 29.88 Watts:

*  Maximum Ptot = 3600 x (Maximum pulse frequency) / Kmax = 3600 x 83 /
9,999,999 = 0.02988 kW

Total power limit for digital output

Given the maximum pulse constant (Kmax) you can enter is 9,999,999 pulses per
kWh, and the maximum pulse frequency for the digital output is 25 Hz, the
maximum total power (Max Ptot) the digital input’'s energy pulsing circuitry can
handle is 9 Watts:

+  Maximum Ptot = 3600 x (Maximum pulse frequency) / Kmax = 3600 x 25/
9,999,999 = 0.009 kW

Typical sources of test errors

If you see excessive errors during accuracy testing, examine your test setup and
test procedures to eliminate typical sources of measurement errors.

Typical sources of accuracy verification testing errors include:

» Loose connections of voltage or current circuits, often caused by worn-out
contacts or terminals. Inspect terminals of test equipment, cables, test
harness and the meter under test.

» Meter ambient temperature is significantly different than 23 °C (73 °F).

» Floating (ungrounded) neutral voltage terminal in any configuration with
unbalanced phase voltages.

» Inadequate meter control power, resulting in the meter resetting during the
test procedure.

» Ambient light interference or sensitivity issues with the optical sensor.
+ Unstable power source causing energy pulsing fluctuations.

* Incorrect test setup: not all phases connected to the reference device or the
energy standard. All phases connected to the meter under test should also be
connected to the reference meter/standard.

* Moisture (condensing humidity), debris or pollution present in the meter under
test.
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MID-compliant models

The PM5331/PM5341 meter models are compliant to the Measuring Instruments

Directive.

Protected setup parameters and functions

Your meter has features and settings that cannot be changed while the meter is

revenue-locked.

In order to prevent modifications to revenue-related settings and data on your
meter, some of the features and parameters on your meter cannot be edited once
the meter is revenue-locked.

Protected setup parameters

Settings

Protected
status

Description

Power system settings

Yes

You cannot change any power system settings
while the meter is locked (for example, power
system type, VT and CT connections, VT and CT
primary and secondary values, system
frequency and phase rotation)

NOTE: For MID compliance, the Power
System must be set to either 3PH4W Wye
Gnd (three-phase 4-wire wye grounded) or
3PH3W DIt Ungnd (three-phase 3-wire
delta ungrounded)

Meter label

Yes

You cannot change the meter label while the
meter is locked

Meter time settings

Yes

You cannot change the meter’s date while the
meter is locked

Energy pulsing

See description

The alarm / energy pulsing LED on the MID-
compliant models is permanently set for energy
pulsing and cannot be disabled or used for
alarms. All other setup parameters for the
energy pulsing LED are also permanently set
and cannot be modified.

Energy reset password Yes You cannot change the energy reset password
while the meter is locked
Protected functions
Functions Description
Resets After the meter is locked, the following resets are disabled:

* Global resets: Meter Initialization (all) and Energies

* Single resets: Energy and Multi-Tariff

For a complete list of protected functions and settings, see your meter’'s Modbus
register list, available from www.schneider-electric.com.

Locking or unlocking the meter

After you initialize the meter, you must lock it in order to conform to MID

standards.

Before you lock your meter:
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» Make sure you have completed all necessary configuration.

+ Perform a meter initialization reset to clear any previously accumulated meter
data.

A lost lock password cannot be recovered.

NOTICE

PERMANENTLY LOCKED DEVICE

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in data loss.

1. Navigate to Maint > Setup > Meter > Lock.

2. Press Edit to activate or deactivate the lock.

w

Enter your lock password.
NOTE: The default password is 0000.

Press + and - to scroll between Active and Inactive.
Press OK to select the option.

Select Yes to confirm the selected option, and exit the screen.

N o g &

Make sure you record and store the lock password in a secure location.
On activating the lock, a lock icon appears on the upper left corner of the
screen.

NOTE: Make sure you record and store the lock password in a secure
location. A lost lock password cannot be recovered.

Setting up the lock password

You can change the lock password on the meter.

NOTE: You cannot change the lock password when the lock is active. To
change the password, make sure the lock is inactive.

A lost lock password cannot be recovered.

NOTICE

PERMANENTLY LOCKED DEVICE

Record your device's user and password information in a secure location.

Failure to follow these instructions can result in data loss.

1. Navigate to Maint > Setup > HMI > Pass.

Press the down arrow to scroll to Revenue Lock in the Passwords screen.
Press Edit to select a password.

Press + to increment the active digit through the numerals 0-9.

Press the left arrow to move to the next digit to the left.

Continue until all values are selected, and then press OK to set the password.

N o o &~ 0w N

Press Yes to save the changes.
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The specifications contained in this section are subject to change without notice.

For installation and wiring information, refer to the meter installation sheet.

Mechanical characteristics

IP degree of protection (IEC 60529)

Display: IP52
Meter body: IP30

Mounting position

Vertical

Display type

Monochrome graphics LCD, 128 x 128 resolution

Display backlight

White LED

Viewable area

67 x 62.5 mm (2.64 x 2.46 in)

Weight

4309

Dimensions W x H x D [protrusion from
cabinet]

96 x 96 x 72mm (depth of meter from housing mounting flange) [13mm]

Panel thickness

6 mm maximum

Electrical characteristics

Measurement accuracy

Measurement type True RMS on three-phase (3P, 3P + N)
64 samples per cycle, zero blind
IEC 61557-12 PMD/[SD|SS]/K70/0.5 (for firmware version 1.1.1 and higher)

Active energy

Class 0.5S as per IEC 62053-22 (for 1A nominal CT when | > 0.15A)

Reactive energy

Class 2S as per |IEC 62053-23 (for 1A nominal CT when | > 0.15A)

Active power

Class 0.5 as per IEC 61557-12 (for firmware version 1.1.1 and higher)

Reactive power

Class 2 as per IEC 61557-12 (for firmware version 1.1.1 and higher)

Apparent power

Class 0.5 as per IEC 61557-12 (for firmware version 1.1.1 and higher)

Current

Class 0.5 as per IEC 61557-12 (for firmware version 1.1.1 and higher)

Voltage (L-N)

Class 0.5 as per IEC 61557-12 (for firmware version 1.1.1 and higher)

Frequency

Class 0.05 as per IEC 61557-12 (for firmware version 1.1.1 and higher)

Power quality accuracy (IEC 61557-12)

Power factor

Class 0.5 (for firmware version 1.1.1 and higher)

Voltage harmonics

Class 5 (for firmware version 1.1.1 and higher)

Voltage THD/thd

Class 5 (for firmware version 1.1.1 and higher)

Current harmonics

Class 5 (for firmware version 1.1.1 and higher)

Current THD

Class 5 (for firmware version 1.1.1 and higher)

Voltage inputs

Maximum VT/PT primary

1.0 MVAC

Specified accuracy range

20-400V L-N/35-690V L-L (Wye) or 35 -600 V L-L (Delta)
UL Listed up to 347 V L-N /600 V L-L

EAV15107-EN0O5

109



PowerLogic™ PM5300 series

Device specifications

(absolute range 35 V L-L to 760 V L-L)

Overload 460 VL-N/800V L-L
Impedance 5MQ
Frequency Measured: 45 to 65 Hz

Nominal: 50 / 60 Hz

Current inputs

CT secondary Nominal: 5Aor1A
Measured current 5mAto85A
Starting current 5mA

Withstand 20 A continuous
50 A at 10 sec/hr
500 A at 1 sec/hr
Impedance <0.3mQ
Frequency Measured: 45 to 65 Hz
Nominal: 50 / 60 Hz
Burden 0.026 VA at8.5A

AC control power

Operating range

100-277 VAC L-N/100-415V L-L +10%

Installation category

CAT II1 300V class per IEC 61010

Burden 5W/11 VAmaxat415VAC
4 W maxat125V DC
Frequency 50/60 Hz + 5 Hz

Ride-through time

80 ms typical at 120V AC and maximum burden
100 ms typical at 230 V AC and maximum burden
100 ms typical at 415 V AC and maximum burden

DC control power

Operating range

125 -250 V DC £20%

Burden

<4 Wat250V DC

Ride-through time

50 ms typical at 125 V DC and maximum burden

Mechanical outputs

Number

2 (selected models)

Maximum output frequency

0.5 Hz maximum (1 second ON / 1 second OFF — minimum times)

Switching current

250 VAC at 8.0 Amps, 25 k cycles, resistive
30V DC at 2.0 Amps, 75 k cycles, resistive
30 V DC at 5.0 Amps,12.5 k cycles, resistive

Isolation 2.5kVrms
Digital outputs

Number 2

Maximum load voltage 40V DC

110

EAV15107-ENO5



Device specifications

PowerLogic™ PM5300 series

Maximum load current

20 mA

ON resistance

50 Q maximum

Pulse frequency

<25Hz

Meter constant

from 1 to 9,999,999 pulses per k_h (k_h = kWh, kVARh or kVAh depending on the energy

parameter selected)

Pulse width

50% duty cycle

Leakage current

0.3 micro Amps

Isolation 5kV rms

Status inputs
Number 2
Voltage OFF 0-4VvDC
Voltage ON 18.5-36VDC
Frequency 2 Hz (T ON min = T OFF min = 250 ms)
Input resistance 110 kQ
Isolation 5kV rms
Response time 20 ms
Whetting output 24V DC/ 8mA max
Input burden 2mA @24V DC

Environmental characteristics

Operating temperature

Meter: -25 to 70 °C (-13 to 158 °F)
Display: -20 to 70 °C (-4 to 158 °F)

Display functions to -25 °C (-13 °F) with reduced performance

Storage temperature

-40 to 85 °C (-40 to 185 °F)

Humidity rating

Operating: 5 — 95% RH non-condensing

Pollution degree

2

Altitude

2000 m CAT 111/ 3000 m CAT Il

Location

Not suitable for wet locations

For indoor use only

LEDs

LED indicators

Heartbeat / communications activity

Green LED

Alarm / energy pulsing LED

Amber LED

Alarm / energy pulsing LED

Type

Amber LED, optical

Maximum pulse rate

2.5kHz

Pulse frequency

50 Hz maximum

Pulse width

200 ps
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PowerLogic™ PM5300 series

Device specifications

Meter constant from 1 to 9,999,999 pulses per k_h (k_h = kWh, kVARh or kVAh depending on the energy
parameter selected)
Fixed at 10,000 pulses per kWh on MID meter models

Wavelength 590 to 635 nm

EMC (electromagnetic compatibility)

Product standards

IEC 61557-12 (IEC 61326-1), IEC 62052-11 and EN50470

Immunity to electrostatic discharge IEC 61000-4-2
Immunity to radiated fields IEC 61000-4-3
Immunity to fast transients IEC 61000-4-4
Immunity to surges IEC 61000-4-5

Immunity to voltage dips and
interruptions

IEC 61000-4-11

Immunity to magnetic fields

IEC 61000-4-8

Immunity to conducted disturbances,
150kHz to 80MHz

IEC 61000-4-6

Radiated and conducted emissions

FCC part 15 Class B, EN55022 Class B

Safety

Europe

CE, as per IEC 61010-1 (3rd Edition), IEC 62052- 11 & IEC61557-121 (for firmware version
1.1.1 and higher)

U.S. and Canada

cULus as per UL61010-1 (3rd Edition)
CAN/CSA-C22.2 No. 61010-1 (3rd Edition)

Measurement category (voltage and
current inputs)

CAT lllupto 400 V L-N /690 V L-L

Dielectric

As per IEC/UL 61010-1 (3rd Edition)

Protective class

Protective Class Il

Double insulated for user-accessible parts

MID compliance

Additional specifications apply to the MID meter models (PM5331 and PM5341).

Applicable MID standards and class
index

+ EN50470-1:2006 Class C
+ EN50470-3:2006 Class C

Type of measuring equipment

Static watt-hour meter

Intended use

Indoor use only, permanently mounted in residential, commercial or light industrial applications,
where levels of vibration and shock are of low significance

Mechanical environment M1
Electromagnetic (EMC) environment E2
Applicable measurements C(kWh)

Voltage at voltage terminals

* 3-phase 4-wire Wye grounded: 3 x 63.5(110) to 3 x 277(480) V AC
* 3-phase 3-wire Delta ungrounded: 3 x 110 to 3 x 480 V L-L

Current Rating (Imin — Iref (Imax))

0.05-5(6) A
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Device specifications

PowerLogic™ PM5300 series

Electrical network frequency 50 Hz
Impulse voltage rating 6 kV
AC voltage rating 4 kV

Main cover sealing type

Wire and crimp

RS-485 communications

Number of ports

1 (optional)

Maximum cable length

1219 m (4000 ft)

Maximum number of devices (unit
loads)

Up to 32 devices on the same bus

Parity Even, Odd, None (1 stop bit for Odd or Even parity; 2 stop bits for None)
Baud rate 9600, 19200, 38400 baud

Protocol Modbus RTU, Modbus ASCII (7 or 8 bit), JBUS

Isolation 2.5 kV RMS, double insulated

Ethernet communications

Number of ports

1 (optional)

Data rate

up to 100 Mbps

Protocol

Modbus TCP and BACnet/IP
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